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Installing CloudNine LAW

General Overview

LAW is an on premise eDiscovery processing platform.  Currently there are two

import engines. The LAW Turbo multi-threaded engine and the classic ED Loader

single threaded engine. Both are Windows based applications and can be installed

on any supported instance of Windows. 

LAW works within a LAN (Local Area Network) environment. This environment

can be within one workstation (typically called an all-in-one) or a large network

of servers.



Installing CloudNine LAW 7

© 2025 CloudNine™

 The standard build out would be 

· Database Server – This is the primary SQL server. This server will host all LAW

databases which are cases created from LAW.

· License Server – LAW accesses a Licenses Manger to check licenses in and

out. This licenses manager can be its own server or you can use your SQL

server.

· Workstation server(s) – The LAW application software is installed on these

server. MS Office or other native applications may also be installed for

additional productions capabilities.

· Network Storage – You network storage will house two parts of data: the

Source data and the Case data commonly call the Case Shell.

For LAW to work, the account that it is set up on must have full

read/write/modify permissions to SQL, the workstations, and network

storage (source data and case data).

The user also needs full read/write/modify permissions to the

workstation, and network storage (source data and case data)

System Requirements
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References

Click on the top left to open the table of Contents

Link to the answer center: https://answercenter.ediscovery.co/litigation/ac/lawdc/welcome-to-

law.html

Fields’s descriptions:  http://answercenter.ediscovery.co/litigation/ac/lawdc/system-export-

fields.html

LAW User Guide:

http://answercenter.ediscovery.co/litigation/ac/law_documentation/LAWUserGuide.pdf

LAW Administration Guide:

http://answercenter.ediscovery.co/litigation/ac/law_documentation/LAWAdminGuide.pdf

LAW License Types: https://answercenter.ediscovery.co/litigation/ac/lawdc/license-types.html

LAW License Matrix: https://answercenter.ediscovery.co/litigation/ac/lawdc/law-license-

matrix.html

https://answercenter.ediscovery.co/litigation/ac/lawdc/welcome-to-law.html
https://answercenter.ediscovery.co/litigation/ac/lawdc/welcome-to-law.html
http://answercenter.ediscovery.co/litigation/ac/lawdc/system-export-fields.html
http://answercenter.ediscovery.co/litigation/ac/lawdc/system-export-fields.html
http://answercenter.ediscovery.co/litigation/ac/law_documentation/LAWUserGuide.pdf
http://answercenter.ediscovery.co/litigation/ac/law_documentation/LAWAdminGuide.pdf
https://answercenter.ediscovery.co/litigation/ac/lawdc/license-types.html
https://answercenter.ediscovery.co/litigation/ac/lawdc/law-license-matrix.html
https://answercenter.ediscovery.co/litigation/ac/lawdc/law-license-matrix.html
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High-Level Checklist

Storage Network should be set up first Answer Center Link Has this been

completed
10/100/1000 Mbps. Gigabit recommended.

System Requirements

Network File Storage should be 3-4 times the

size of the intended source data

Create a System Account that will need full

read, write, and modify access to

Network Storage, SQL, Source Data, and

Workstations

MS Domain network required

Setting up you SQL Server Answer Center

Link

Has this been

completed
How large should your SQL server be?

 - Do you know how many SQL cores you need?
How Large Should My SQL Serve Be??

 - Do you know how much RAM you need?

 - SQL Server Hard drive space System Requirements

Install the OS of your choice

 - Microsoft Windows 10 or 11

System Requirements
 - Microsoft Windows Server 2016 (version 1809)

 - Microsoft Windows Server 2019 (version 1903)

 - Microsoft Windows Server 2022

Install SQL of your choice

 - Microsoft SQL Server 2016

System Requirements

Installation Steps

 - Microsoft SQL Server 2017

 - Microsoft SQL Server 2019

 - Microsoft SQL Server 2023

Install Microsoft SQL Server Management Studio

Add System Account into SQL with Full Access Step 2: Add SQL use Account for LAW

 

SQL Server User Account Options

Enable Named Pipes Protocol Enable Named Pipes Protocol

Ports Needed for LAW activity

 - Outgoing: System Requirements

Opening Windows Firewall Ports for SQL - ms-sql-s -> 1433 (TCP/UDP)
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Setting up you SQL Server Answer Center

Link

Has this been

completed
 - www, http -> 80 (TCP)

 - https -> 443 (TCP/UDP)

 - microsoft-ds -> 445 (TCP/UDP)

 - smtp -> 25 (TCP) * Configurable via Tools->Options-

>Notifications

 - Sentinel RMS Server (3rd party) -> 5093 (UDP)

 - Ports needed for LAWtsi

 - Outgoing:

 - ms-sql-s -> 1433 (TCP/UDP)

 - www, http -> 80 (TCP)

 - microsoft-ds -> 445 (TCP/UDP)

 - Sentinel RMS Server (3rd party) -> 5093 (UDP)

 - Note: This interfaces with 3rd party TWAIN drivers

which may use various network communication

methods to access devices. Ports would have to be

determined by the vendor.

Ports LAW Management Console

 - Outgoing:

System Requirements

Opening Windows Firewall Ports for SQL

 - ms-sql-s -> 1433 (TCP/UDP)

 - microsoft-ds -> 445 (TCP/UDP)

 - UDP -> 8401 (UDP) * Configurable via Tools-

>Options

 - Incoming:

 - UDP -> 8401 (UDP) * Configurable via Tools-

>Options

 Configuring your SQL Server max memory

allocation.

 - Open the SQL Instance through the SQL Server

Management Studio.

Suggestions for configuring your instance of SQL for use with LAW

 - Then right click on the Instance name and select

Properties.

 - Then select the Memory tab.

 - The Maximum server memory (in MB): should be

approximately 80% of your servers’ available memory

unless you have multiple instances on the same server
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Setting up your Licenses Manager Link in Answer Center Has this been

completed
 - Are you going to put the license manager on the

SQL Server or on its own server?

 - If SQL proceed with installing the Thales Sentinel

RMS Licenses Manager on the SQL Server
License Manager - If its own workstation, follow the workstations

steps below to install Thales Sentinel RMS Licenses

manager.

 - The Licenses Manger UI is built into LAW. Install

LAW for the UI but stop at the LAW Configuration

Utility

LAW Installer for License Manager UI

LAW ED Loader/Turbo* Link in Answer Center Has this been

completed
Hardware Specs 

 - Computer/Processing - 8core

System Requirements

 - Memory (RAM) = 16gb (Workstations in the

Turbo Pool or are running the Turbo Service will

need 32gb of RAM)

 - Hard Drive - 100gb of SSD

 - Display - 1080p

Install the OS of your choice

 - Microsoft Windows 10 or 11

System Requirements
 - Microsoft Windows Server 2016 (version 1809)

 - Microsoft Windows Server 2019 (version 1903)

 - Microsoft Windows Server 2022

Microsoft Office

 - Microsoft Office 2010

System Requirements

 - Microsoft Office 2013

 - Microsoft Office 2016

 - Microsoft Office 365 (Local Install)

 - Microsoft Office 2019

*NOTE if you are using ED Loader your Office installation must be 32bit. If you are using

Turbo Import you can install 64-bit Office.

Create an Outlook dummy account Configuring Outlook for ED Loader

Install All Microsoft Language Packs or the

ones that you want to work with
LAW Workstation Considersations
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LAW ED Loader/Turbo* Link in Answer Center Has this been

completed
Chrome or other browser programs. Set up

printer settings

Solidworks eDrawings 2013

System Requirements
IrfanView and all plugins

Adobe Reader (32bit) and other PDF software

(like Foxit). Set up Printer settings on both

Turn off Microsoft 'File Block Settings' in

office products

Turn off the caching of thumbnails in hidden

thumbs.db files
Turn off the Caching of Thumbnails

If using Remote Desktop: Turn off the Local

Printers

ABBYY Fine Reader Engine ABBYY Engine

Lotus Notes 8.5 or 9 (once installed open it

and selected to turn off popups)
System Requirements

Show hidden files and file extensions Show Hidden Files and File Extensions

Lower User Account Control Settings to 'Never

Notify'
Lower User Account Control Settings to 'Never Notify'

Install LAW LAW Installer

Setting up LAW with LAW Configuration. Set

up NIST,  File Type Management and select the

machines that will run the LAW service for

Turbo Import and Imager to work.

LAW Configuration Utility

Open LAW Management Console Open LMC

Encryption and TLS Protocols Encryption and TLS Protocols

Antivirus Best Practices and

Recommendations
Antivirus Best Practies and Recommendations

LAW FIPS Compliance and Configuration LAW FIPS Compliance and Configuration

Set up your Queries and Grid Views Grid View Profiles

Set up your LAW case preferences Set Up Preferences

*Note if you are setting up Turbo make sure you see that workstations in the Turbo Pool need more RAM. 

https://answercenter.ediscovery.co/litigation/ac/lawdc/grid-view-profiles.html
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Detailed Checklist

System Requirements

Recommended System Specs

Your needs will vary depending on the volume of source data being processed. The following are

our recommended specifications for running LAW:

Current Version is LAW 7.12

Create a

System/Network

Account 

For the LAW program to work, the account that it is set up on must

have full read/write/modify permissions to SQL, the workstations,

and network storage (source data and case data).

The User only needs full read/write/modify permissions the

workstation, and network storage (source data and case data)

Processor 8-core @ 2.5+ GHz

ED Loader Memory

(RAM)

16+ GB

Turbo Pool

Workstations

Memory (RAM)

32+ GB

It's recommended systems have 4 GB of RAM per processing core.

Note: “Ideal” processing requirements may call for a higher allocation of

core/RAM resources.

Workstation Hard

Drive

Solid State Drive w/ 100 GB+ free space

CloudNine LAW uses temporary storage. When working with large files, a

significant amount of drive space may be used.

SQL Server Hard

Drive

Solid State Drive w/ 1TB+ free space

It's recommended that you consult your DB Admin from here

Network File

Storage

(Case

Databases/Images/Text/

Native Documents) 

When importing electronic documents, the storage size

requirements of your data can vary greatly based on the sources

being used. Data can inflate up to 3-4 times its original size.
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Display 1080p monitor resolution

Network 10/100/1000 Mbps. Gigabit recommended.

  MS Domain network required

Applicable only if using a network server to host Case Files and their

associated documents.

Supported

Operating Systems

· Microsoft Windows 10 or 11

· Microsoft Windows Server 2016 (version 1809)

· Microsoft Windows Server 2019 (version 1903)

· Microsoft Windows Server 2022

Only 64-bit versions of Microsoft Windows are supported.

Both of CloudNine™ LAW engines Turbo and ED Loader uses the list of

time zones from the user’s operating system. 

Supported SQL

Database Software

· Microsoft SQL Server 2016

· Microsoft SQL Server 2017

· Microsoft SQL Server 2019

· Microsoft SQL Server 2022

Express versions of the SQL Server versions listed above are supported for

smaller Case Files as they have a limit of 10 GB per database.

Supported Scanner

Hardware

· Scanners with ISIS drivers (Supported Scanners) 

· Scanners with TWAIN drivers via LAWtsi (Touch Screen

Interface)

Antivirus Software Antivirus is not required, but highly recommended to protect you

from damage caused by viruses embedded within your

processed documents.

.NET Framework 3.5 and 4.8 or higher

https://www.opentext.com/support/isis-cloud-capture-certified-scanner-drivers
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ABBYY OCR engine The ABBYY OCR engine installer can be found here: ABBYY ENGINE

All in One System Requirements (An all

in one box usually has LAW and SQL on

the same box)

Depending on intended use, the all-in-one

could be smaller. Please call customer

support for more information.

Processor and RAM 16 Cores and 64GB of RAM

Operating Systems and SQL Windows 10, 11 or Server 2019

Hard Drive Space 1tb of SSD

Native Applications

There are several native applications that can be used with LAW. Native applications are used for

viewing documents, E-Printing, and TIFF Conversion. The following applications are supported:

Adobe Acrobat
· Adobe Reader

· Adobe Acrobat Pro X

· Adobe Acrobat Reader X

· Adobe Acrobat Standard XI

· Adobe Acrobat Pro XI

· Adobe Acrobat Reader XI

· Adobe DC (Standard or Pro)

· (non 64 bit)

Avantstar Quick

View Plus

· Avantstar Quick View Plus 13 Professional

· Avantstar Quick View Plus 17

· Avantstar Quick View Plus 2020

See Avantstar's license agreement prior to using this application with LAW.

https://answercenter.ediscovery.co/Litigation/ac/law_documentation/ABBYYEngine11.rev1.exe.zip
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Corel Word Perfect Corel Word Perfect 12

Lotus/IBM Notes · Lotus Notes 8.5

· IBM Notes 9

Lotus/IBM Notes must be installed in Single-User mode.

Microsoft Office · Microsoft Office 2010

· Microsoft Office 2013

· Microsoft Office 2016

· Microsoft Office 365 (Local Install)

· Microsoft Office 2019

For Turbo Import, the 64-bit Office Suite may be used for ingestion and Batch

Tiffing (LAW 7.5+)

ED Loader and PST reconstitution work-flows require 32-bit Office.

Microsoft Project · Microsoft Project 2003

· Microsoft Project 2007

· Microsoft Project 2010

· Microsoft Project 2013

· Microsoft Project 2016

· Microsoft Project 2019

Only 32-bit versions are supported.
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Microsoft Visio · Microsoft Visio 2003

· Microsoft Visio 2007

· Microsoft Visio 2010

· Microsoft Visio 2013

· Microsoft Visio 2016

· Microsoft Visio 2019

Only 32-bit versions are supported.

Oracle AutoView · Oracle AutoView 19

· Oracle AutoView 20 

· Oracle AutoView 21 

SOLIDWORKS

eDrawing

SOLIDWORKS eDrawings Viewer 2013

32-bit version only

Web Browser · Microsoft Edge

Touch Screen Able to work with 17 Inch monitor with a Magic Touch touch screen. 

Only for the TSI

Demo Version Evaluation versions of LAWtsi Scan are allowed to run 25 times and

are limited to 50 documents per case. Cases over 50 documents

cannot be opened by a demo version of LAWtsi. 

Only for the TSI

Required LAW Ports

The required port exceptions for LAW are listed below
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LAW · ms-sql-s -> 1433 (TCP/UDP)

· www, http -> 80 (TCP)

· https -> 443 (TCP/UDP)

· Microsoft-ds -> 445 (TCP/UDP)

· smtp -> 25 (TCP) * Configurable via Tools->Options-

>Notifications

· Sentinel RMS Server (3rd party) -> 5093 (UDP) 

Sentinel calls out to this site: https://cloudnine.prod.sentinelcloud.com/

LAWtsi · ms-sql-s -> 1433 (TCP/UDP)

· www, http -> 80 (TCP)

· Microsoft-ds -> 445 (TCP/UDP)

· Note: LAW TSI interfaces with 3rd party TWAIN drivers which

may use various network communication methods to access

devices. Ports would have to be determined by your Scanner

manufacturer/vendor.

LAW Management

Console (LMC)

Outgoing:

· ms-sql-s -> 1433 (TCP/UDP)

· Microsoft-ds -> 445 (TCP/UDP)

· UDP -> 8401 (UDP) * Configurable via Tools->Options

Incoming:

· UDP -> 8401 (UDP) * Configurable via Tools->Options

A Knowledge Based Article on this subject can be found here: How do I move cases to a

different environment? (cloudnine.com)

https://nam04.safelinks.protection.outlook.com/?url=https://cloudnine.prod.sentinelcloud.com/&data=05|02|jtucker@cloudnine.com|5fd02bf9e2bb495ef59708dda1d815fa|6cdec2cfa0b34e5cba0111153c5a0f92|0|0|638844671658585901|Unknown|TWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ==|0|||&sdata=dbl9pI6jtR03R9DlEbz+bJk610PUY1DjC0pPGKcr9Bw=&reserved=0
https://kb.cloudnine.com/how-do-i-move-cases-to-a-different-environment
https://kb.cloudnine.com/how-do-i-move-cases-to-a-different-environment
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Database Installation and Configuration

CloudNine™ LAW requires separate database software to be installed and configured properly.  To

Help with setting up SQL we provide these pages

·

SQL 2017  2022 Setup

·

SQL Express

·

SQL Considerations for LAW

·

Configuring LAW and SQL

·

Troubleshooting SQL Configuration
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SQL 2017 & 2022 Setup

The images on the left section describes an example of a known, working setup of SQL Server

2017. 

The images on the right section describe an example of a known working setup of SQL Server 2022.

How Large Should my SQL Serve be??
 

Installation Steps
 

Step 1: Install SQL Server 2017

Step 2: Add SQL use Account for LAW
 

How Large Should my SQL Server be??

Microsoft can't recommend more than 1 core and 2gb of RAM on the SQL machine, because they do

not know what applications you are running on SQL. LAW has alot of network traffic with SQL and

for that reason we have created this equation to help right size your SQL Server. 

Calculating LAW SQL Cores

· At minimum – the Total Number of SQL Cores should = The # number of total LAW

instances* that can communicate or interact with SQL ÷ 3 

(*Some LAW components are single threaded and others are muti-threaded. If you are using ED

Loader, use the number of concurrent licenses you have as the number of instances. If you are

using Turbo add concurrent licenses and how many cores are available in your Turbo pool.) 

· Add one core for the OS

Calculating LAW SQL RAM 

· At minimum – the Total amount of SQL RAM should = The # number of LAW instances* that can

communicate or interact with SQL × 4 

oNote when RAM starts to go over 100GB it is more of a bell curve and must be adjusted by

each environment.

Installation Steps

Step 1: Install SQL Server 2017 and 2022
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SQL Server 2017 and 2022 with an installation of Microsoft SQL Server Management

Studio 17 & SQL Server Management Studio (SSMS) 20.2.1

1. Download the installer file for SQL Server 2017 or SQL Server 2022 from the Microsoft

website.

2. Run the installation file. The SQL Server 2017 or SQL Server 2022 installation window

opens.

    

3. Select Custom then follow prompts to continue.

4. Specify SQL Server media download target location will open in a new window.  Browse

to the location that you would like to save your SQL files.

    

5. After setting the installation path, then select Install.

6.   In SQL Server Installation Setup dialog box select the Installation tab.
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7.   Select Install SQL Server Management Tools to download and install SQL Server

Management Studio 17.6+ or SQL Server Management Studio (SSMS) 20.2.1

Microsoft SQL Server Management Studio or SSMS is a software application that is

used for configuring, managing, and administering all components within Microsoft

SQL Server. The tool includes both script editors and graphical tools which work

with objects and features of the server.

(https://en.wikipedia.org/wiki/SQL_Server_Management_Studio)  

8.   Select New SQL Server Standalone installation or add features to an existing

installation.

9.   The SQL Server 2017 Setup window with License Terms will open next.

      

10.  If you accept the license terms then select Next.

11. SQL Server 2022 you can select if you want to have the program check for updates.

Make your selection and then select Next.

12. Installing SQL Server 2022 may give you a warning about the Windows Firewall ports

that need to be enabled. We suggest opening ports 1433 and 1434 after installation.

Steps to do so can be found here 
Opening Windows Firewall Ports for SQL

            

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms


CloudNine™  LAW26

© 2025 CloudNine™

13. SQL Server 2022, for our purposes we do not need to connect to Azure. Please see your

DB Admin for your company's needs.

         

13. Feature Selection window will open in a new window.

· SQL Server 2017 Setup both Database Engine Services and Client Tools Connectivity

are required.

· SQL Server 2022 Setup only needs Database Engine Services. 

· Please refer to your SQL database administrator for other features that you may need. 

   

14.  Select or deselect options according to your SQL database administrator's guidelines,

then select Next. 

15.  The Instance Configuration window will open. Select Named instance, if you would like

to change the instance name.  The default is SQLSERVER for SQL 2017 and

MSSQLSERVER for SQL 2022
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Make sure to document your installs so that server instances can easily be reproduced.

·   Computer/server name where SQL is installed

·   SQL system administrator password

·   SQL Instance name

If you write your password down, it is recommended to keep it in a secure location,

possibly off-site.

16.  Select Next after making any necessary changes.

17.  The SQL Server 2017 Setup: Server Configuration window will open.  The services will

vary depending on options chosen during Feature Selection.

    

18.  SQL Server Browser service, under Startup Type, needs to be set to Automatic.

Some Services are not needed by LAW and/or Explore
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You can install the SQL Server Agent if you intend to run jobs on the server or do

maintenance tasks such as automated backups.  However, this function is best

handled by a SQL DBA.  

The other services (SQL Server Analysis and SQL Server Reporting Services) are

unnecessary for LAW/CloudNine™ Explore and consume valuable resources on your

server.

· It is best to locate your databases (.mdf and .ldf) and your tempdb on separate physical

disks; preferably NOT a USB-connected disk.  This makes it easier to troubleshoot disk

access problems, should they occur.

· We do not recommend the use of NTFS data file encryption or compression on SQL server

databases and log files.

19.  Set a System Admin Password.  

20.  Click Next. 

21.  In Database Engine Configuration dialog box, select Mixed Mode (SQL Server

authentication and Windows authentication).

  

22.  In the Enter password and Confirm password fields, type the SQL System administrator

password you want to use. Recommended: write the password down in a secure

location. 

23.  Under Specify SQL Server administrators, click Add Current User. Add other users as

necessary, and then click Next and then Install

24.  When the installation is complete the Complete window will open.

25.  Select Close.
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Step 2: Add SQL use Account for LAW

1.  Start SQL Server Management Studio. 

2.  Login to the new SQL Server instance. 

3.  Expand Security, right click Logins, and then click New User or New Login.... 

4.  In Login name type LAW_User.

5.  Select SQL Server authentication. 

6.  In the Password and Confirm password fields type (Contact customer support for password

assistance.). 

7.  Deselect Enforce password expiration, Enforce password policy, and User must change

password at next login. 

8.  In the left panel of the dialog box, click Select Server Roles and then select dbcreator. The

Public role should already be checked.

9.  Click OK.

10. Close Microsoft SQL Management Studio.

You can use a 
custom login

 and password for SQL Server Authentication.
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SQL Express

Standard Microsoft SQL Server is recommended, but Express may be used in environments with

small cases (Express has a limit of 10GB per database).  See the 
System Requirements

 for more details

on requirements for proper setup.

Other SQL Express limitations

· 1GB maximum memory used by the database engine.

· 10GB maximum database size

· 1MB maximum buffer cache

· CPU the lesser of one (1) socket or four (4) cores (number of SQL user connections NOT limited)

If you believe that you are going to exceed any of these limitations, then you should build your SQL

server to work with a full SQL installation.

Some more limitations are listed here: Main Limitations of SQL Server Express Editions - SQLNetHub

Proper installation and configuration of SQL Server should be discussed with your SQL

database administrator.

The following instructions provide sample values to setup a configuration of SQL Server (Express)

with Tools.  Use this as a starting point when discussing a production oriented SQL Server

configuration with your SQL database administrator. 

Installation Tasks

· Instance name: can use default -- for example, SQLEXPRESS

· Features: Database Engine Services and Management Tools - Basic

· Account Name: NT AUTHORITY\ NETWORK SERVICE

· Password = leave blank (default)

· Database Engine Configuration dialog box: Mixed Mode (SQL Server authentication and Windows

authentication)

· SQL Administrator password: select a password of your choice.

· User accounts: Add Current User. Or add at least one Windows login or domain user account.

https://www.sqlnethub.com/blog/main-limitations-of-sql-server-express-editions/
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SQL Considerations for LAW

The Answer Center provides the minimum and recommended versions of SQL for use with your

specific version of CloudNine™ LAW. It is recommended to consult the 
system requirements

 before

installing SQL.

Suggestions for configuring your instance of SQL for use with LAW
 

Suggestions for SQL maintenance

Opening Windows Firewall Ports for SQL

Suggestions for configuring your instance of SQL for use with LAW

· SQL Server max memory allocation is uncapped by

default.  This should be capped at approximately 80% of

the physical memory allocated to the machine.  For

example, a server with 32 GB of physical RAM

·  should be capped in SQL Server Management Studio at

25600 MB. 

        

Configuring you SQL Server max memory allocation

1.  Open the SQL Instance through the SQL Server Management Studio.

2.  Then right click on the Instance name and select Properties.
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3. Select the Memory tab. 

    

4. The Maximum server

memory (in MB):

should be approximately

80% of your server's

available memory unless

you have multiple SQL

instances on the same server.

· Leave the “auto create statistics” and “auto update statistics” options on for all user databases.

Only in very rare cases should these be turned off, and if they are turned off, then you must

manually update the statistics yourself.  Please see Microsoft's website for more information.

· Do not use the “auto shrink” database option, as it can waste SQL Server resources unnecessarily

and contribute to index fragmentation. Instead, if you need to shrink a database, do so manually.

For more information please see Microsoft's website on Considerations for the "autogrow" and

"autoshrink" settings.

· Do not rely on AUTOGROWTH to automatically manage the size of your databases. Instead,

proactively monitor and alter database size as circumstances dictate. Only use AUTOGROWTH to

deal with unexpected growth  For more information please see Microsoft's website on

Considerations for the "autogrow" and "autoshrink" settings.

Suggestions for SQL maintenance

· Set up daily full backups of your databases.  You can use a job to schedule your backups as long

as you have SQL Agent service running.

· Perform full backups during periods of low user activity to minimize the impact of backups on

users. 

· Periodically perform "test backup restores" to ensure that your backups are good and can be

restored. 

· Store backups off site and in a secure location. 

Enable Named Pipes Protocol

https://blogs.msdn.microsoft.com/buckwoody/2009/08/18/sql-server-best-practices-auto-create-and-auto-update-statistics-should-be-on-most-of-the-time/
https://support.microsoft.com/en-us/help/315512/considerations-for-the-autogrow-and-autoshrink-settings-in-sql-server
https://support.microsoft.com/en-us/help/315512/considerations-for-the-autogrow-and-autoshrink-settings-in-sql-server
https://support.microsoft.com/en-us/help/315512/considerations-for-the-autogrow-and-autoshrink-settings-in-sql-server
https://support.microsoft.com/en-us/help/315512/considerations-for-the-autogrow-and-autoshrink-settings-in-sql-server
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1. Open SQL Server Configuration Manager

2. Under SQL Server Network Configuration > Protocols for MSSQLSERVER

3. Find Named Pipes, right click and enable.

4. Restart the SQL service.

Opening Windows Firewall Ports for SQL

Enable TCP/IP

1. Open SQL Server Configuration Manager.

2. In the left pane, expand SQL Server Network Configuration.

3. Click Protocols for <SQL Server instance name>.

4. In the right pane, right-click TCP/IP and select Enable.

5. A warning dialog displays with the message Any changes made will be saved; however, they

will not take effect until the service is stopped and restarted. Click OK.

6. In the left pane, click SQL Server Services.

7. In the right pane, right-click SQL Server <SQL Server instance name> and select Restart.

Open port 1433

1. Open Windows Defender Firewall with Advanced Security.

2. Click Inbound Rules.

3. Under Actions, click New Rule.

4. Select Port and click Next.

5. Select TCP.

6. Select Specific local ports, enter 1433, and click Next.

7. Select Allow connection and click Next.

8. Accept all defaults Domain and Private and click Next.

9. Enter a Name for the rule.

10. (Optional) Enter a Description for the rule.

11. Click Finish.
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Open port 1434

12. Open Windows Defender Firewall with Advanced Security.

13. Click Inbound Rules.

14. Under Actions, click New Rule.

15. Select Port and click Next.

16. Select UDP

17. Select Specific local ports, enter 1434, and click Next.

18. Select Allow connection and click Next.

19. Accept all defaults Domain and Private and click Next.

20. Enter a Name for the rule.

21. (Optional) Enter a Description for the rule.

22. Click Finish.

Manually Add System Account into SQL with Full Access

Add the System/Network Account into SQL and with Full Read, Write and Modify access.

Open SQL Management Studio, expand the Security folder and

Right Click on Logins > “New Login”

On the new login screen

choose ‘Search’
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On the search screen ensure you are searching for

the Entire Directory, type in the username, check

Names, then choose ok.

After you click OK, Click Server Roles

and check ‘sysadmin’ then ok

Use this method when using SQL Server

for other applications in addition to

CloudNine™ LAW. This option helps to

prevent users of SQL Server from

accessing and modifying any other

existing databases yet provides

additional security for your databases.

To create a custom SQL user account: ·

Setup a SQL Server user with

create/modify permissions. · The

username and password will be

referenced when accessing SQL

(Database management, NIST storage,

File Type Database Management, and for

case list storage). User: (Custom SQL

login following SQL Guidelines) Pwd: (Custom password following SQL Guidelines) When using this

option, the security mode for SQL Server must be set to SQL Server and Windows for mixed-mode

authentication.
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Configuring LAW and SQL

SQL Server User Account Options  Create a SQL Server Authentication Custom Login

Adding SQL Server Authentication Custom Login to Existing Databases

SQL Server User Account Options

There are three methods of specifying user accounts for use with SQL Server.  It is strongly

recommended that the same login is used for configuring the LAW Environment, NIST, and File

Type Management databases. 

Create a Global Default User

for CloudNine™ LAW

Create SQL Server

Authentication custom login

for CloudNine™ LAW

Create Individual Users with

Integrated Security

Use this method when using

SQL Server for other

applications in addition to

CloudNine™ LAW. This option

helps to prevent users of SQL

Server from accessing and

modifying any other existing

databases.

To create a generic global

user account using this

method:

· Setup a SQL Server user with

create/modify permissions. 

· The user name and password

should be:

User: LAW_User

Pwd: (Contact customer

support for assistance.)

When using the default user, the

security mode for SQL Server

must be set to SQL Server and

Windows or mixed-mode

authentication. 

Use this method when using

SQL Server for other

applications in addition to

CloudNine™ LAW. This option

helps to prevent users of SQL

Server from accessing and

modifying any other existing

databases yet provides

additional security for your

databases.

To create a custom SQL user

account:

· Setup a SQL Server user with

create/modify permissions. 

· The user name and password

will be referenced whenever

accessing SQL (Database

management, NIST storage,

File Type Database

Management, and for caselist

storage).

User: (Custom SQL login

following SQL Guidelines)

Pwd: (Custom password

following SQL Guidelines)

This method allows a user to

create SQL Server cases

without adding a special user

to SQL Server as long as the

current user has database

create permissions on the

specified SQL Server.

Windows integrated security

may be used when

accessing/creating SQL Server

cases. 

If using this method, each user

must be set-up on the SQL

Server to allow access to the

case.

To enable this feature:

· Select the Use Windows NT

integrated security option

when specifying the

database backend for newly

created cases.
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Create a Global Default User

for CloudNine™ LAW

Create SQL Server

Authentication custom login

for CloudNine™ LAW

Create Individual Users with

Integrated Security

When using this option, the

security mode for SQL Server

must be set to SQL Server and

Windows for mixed-mode

authentication. 

Create a SQL Server Authentication Custom Login

How to create a SQL Server Authenticated custom SQL login for CloudNine LAW using

a custom name and/ or password.

The option for the custom SQL Server Authenticated login is only available for use with

LAW 7.1 and higher.  It is not supported on workstations that are using earlier versions of

LAW.

1. Start SQL Server Management Studio. This is located in Start > All Programs > Microsoft

SQL Server > SQL Server Management Studio. 

Windows 10: >Microsoft SQL Server> SQL Server Management Studio. 

2. Login to the SQL Server instance. 

3. Expand Security, right click Logins, and then select New User. 

4. In Login name type (the desired login name).

5. Select SQL Server authentication. 

6. In the Password and Confirm password fields type the desired password. (Please make a note

of this password in a secure place as LAW customer support does not have a means to reset

this password if forgotten or misplaced). 

7. Select/deselect password options based on your

company policy: Enforce password policy, Enforce

Password expiration, and User must change

password at next login.
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If opting to leave Enforce password policy, Enforce Password expiration, and User

must change password at next login selected; when the password is changed then you

will need to also update each LAW case and database through LAW that uses that

password.  See Adding SQL Server Authentication custom login for more information

about updating the passwords. 

8. In the left panel of the dialog box, click Select Server Roles and then select dbcreator. The

Public role should already be selected by default.

9. Click OK.

10. Close Microsoft SQL Management Studio. 

Adding SQL Server Authentication Custom Login to

Existing Databases
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The Custom SQL Server Authenticated login is available for all newly created databases by

simply using the login and password during case creation.  For existing cases, the case will

need to be mapped to the custom login in SQL. 

1. Start SQL Server Management Studio. This is located in Start > All Programs > Microsoft

SQL Server > SQL Server Management Studio. 

Windows 10: >Microsoft SQL Server> SQL Server Management Studio. 

2. Login to the SQL Server instance as a SQL administrator (or on an account with elevated

privileges). 

3. Expand Security, expand Logins.

4. Right click on the newly created custom login, and then select Properties.

5. Select User Mapping.

6. Select the box for the database  and then select db_owner for each database that the new

login is to be provisioned.  

The database role, db_owner, needs to be selected following the selection of each database.

 Selecting multiple databases and then selecting the role db_owner will only add

db_owner to the last database selected.

If using the SQL SA custom login in the

LAW Configuration Utility
, then consider adding,

under User Mapping, the following databases

as well:

LAW Configuration Utility Tab: Example of database name in SQL.

 Management Database: LAW5_Management

 File Type Database: LAW5_Management (and other external file type databases

in SQL)

 NIST: LAW_NIST 

*Note: the NIST database uses the same login information

as the Management Database.

Consider adding the following databases to the custom login: Databases to consider adding to the

SQL SA custom login

Database Function Example of database name in SQL.

LAW Distributed batch

processing

LAW5_BatchControl 

*Login and password should be the same as the login used

for the Management Database.

Explore case management EDA_Management

7. When all databases have been mapped, then select OK.

8. Then launch LAW.

9. On the File menu select Open Case.

10. The Open Case dialog box appears.

11. Highlight the SQL case that you want to change to the custom SQL login.

12. Either select Properties or right click on the case and select Properties.

13. The Case Properties dialog box appears.

14. The SQL Server Connection Details section is available for updates to Server Name, Use

Windows Authentication, User name, and Password.

15. Change the user name and password to the custom SQL login and password. 

16. Select OK  to close the Case Properties window. 

17. The new login is amended to the case. 

If during SQL SA custom login creation Enforce password policy, Enforce Password

expiration, and User must change password at next login were selected, then note all

databases that are using the SQL SA custom login.  Each LAW case updated or created with

the SQL SA custom login will need to be updated through LAW, using steps 8 - 17, after the

password is updated in SQL.  If the Management database, File Type database, and/or NIST

database uses a SQL SA custom login then the configuration utility will need to be updated

with the new password on each machine using LAW.
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Troubleshooting SQL Configuration

After configuring SQL, you may need to confirm that the services are running or make needed

changes.

1. Go to Windows Start, and Select Microsoft SQL Server (Version #) and expand the selection.

2. Select SQL Server (Version #) Configuration Manager.

3. The SQL Server Configuration Manager opens in a new window.

4. Select SQL Server Services.

5. Confirm that both SQL Server and SQL Server Browser are running and the Start Mode is set to

Automatic.

6. If the Start Mode is NOT set to Automatic:

a. Right click on the name (SQL Server or SQL Server Browser).

b. Select Start.

7. If SQL Server or SQL Server Browser are not running:

a. Right click on the name (SQL Server or SQL Server Browser) and select Properties.

b. A new window opens for the Properties of the selected service.

c. Select the Service tab.

d. Select Start Mode.

e. Choose Automatic from the drop-down menu.

f. Click OK.

8. Expand SQL Server Network Configuration.

9. Select Protocols for (SQL or SQLExpress depending on your SQL).

10. TCP/IP should be Enabled.  If not, right click on TCP/IP and select Enable.

Add SQL Instance Name to LAW
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1. On the File menu click New Case.

  Or 

     On the main form toolbar click New Case. 

2. The Select Database Engine dialog box appears.

  

3.  Select SQL Server/ SQL Express

4.  Click OK. 

5.  New Case - Properties opens in a new window.

   

6.  Type the SQL instance name and select an authentication mode for the new case.

If you are installing a full version of SQL, then you would only have the name of your SQL

Instance in the screenshot above.  It would not include\SQLExpress. 

7.  Continue the case creation process Creating a New Case.
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Licensing

Licenses

To authenticate your LAW installation, you will need a software License. There are several Licenses

available for purchase, each providing access to different bundles of features and functions found

within LAW. Each of these Licenses comes with a set number of Seats, which are the total number

of users who access them at any given time.

For an overview of the different features and functionality that come bundled with

each License, read more about License Types.

License Server

All software Licenses must be hosted on a License Server, which can only be assigned, monitored

and managed through the License Manager utility. The License Manager utility is also used to

activate software Licenses (known as Product Keys) on the License Server, and track their

available Seats. Any computer or virtual machine with the Sentinel RMS License Manager

installed may be assigned as a License Server through the License Manager utility. The current

version of the License Manager can be found inside of the LAW install. i.e. to install the License

Manager you just need to install LAW. However, you do not need to set up LAW to work on the

License Server.

For instructions on installing the Sentinel RMS License Manager, refer to the

Sentinel Installer
 topic.

For instructions on activating Licenses within the License Manager utility after a

fresh LAW installation, read the 
License Server

 topic.

For advanced help with the License Manager utility, please contact customer

support. They will direct you to an appropriate set of instructions for your needs.

It is best practice to have the license server be a separate computer from the computer(s)

where LAW is used. The SQL server makes for a great location for the license manager.

Licensing Styles

https://answercenter.ediscovery.co/litigation/ac/lawdc/license-types.html
https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
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LAW can use two different styles of licenses, but can only use one style at a time:

· Software Key Licensing

With software key licensing, licenses are bundled into software product keys, which are hosted on

the license server. Software product keys are activated and managed on the license server using the

License Manager. Licenses in activated software product keys can be monitored in both the License

Manager and the LAW Profile Manager. 

· Undocked Keys Licensing

If you have a need to use LAW off-site or in an internet restricted area, you can undock a license and

borrow it. For more information see this page: 
Undocked Keys

 

A software product key contains the specific LAW licenses and license seats assigned to the key. For

more information about CloudNine™ LAW, see License Types.

LAW Profile Manager

Once your Licenses have been activated on the License

Server, you can access their available Seats by selecting a

License Profile from within the LAW Profile Manager,

which opens every time LAW is launched unless the

Prompt for profile when starting LAW is disabled.

Custom License Profiles are configurable by an

administrator, and determine which Seats are to be

occupied by a given instance of LAW.

For more information on using or configuring custom License Profiles within the

LAW Profile Manager, please see this page or contact customer support.

https://answercenter.ediscovery.co/litigation/ac/lawdc/license-types.html
https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
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Please note that machine specifics of the computer/server hosting the license is used

in generating the authorization for licensing. If you are planning to make changes to

your license server that would affect the machine’s unique identifiers, then please

contact LAW customer support to assist with the license transfer prior to making the

changes to avoid any disruption of service. 

Currently virtual machines set to auto migration in cluster environments are not

supported because auto migration will change the machine unique identifiers and will

invalidate the license keys. For cluster environments it is recommend that you turn off

auto migration on the virtual license server, to avoid any disruption of service.

https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
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License Server

To successfully launch LAW, you will need LAW Licenses. They can be checked out of the Licenses

Manager. To set up a License Manger you will need

· To install the Sentinel RMS License Manager. For instructions on installing the Sentinel RMS

License Manager, refer to the 
Sentinel Installer

 topic.

· Access to any License Server hosting an available LAW License. The License Manager utility

is used to designate License Servers, activate your software Licenses (also known as Product

Keys) and track the available Seats for those Licenses.

The License Manager can also exist on the SQL server. This way you don't have to

allocate resources on a separate License Server.

If you are putting the License Manager on a virtual machine, you will want to make

the IP static

Sentinel Installer

The Sentinel RMS License Manager is installed through an executable package known as the

Sentinel Installer. You can obtain this installer from the link below:

NOTE: Starting with LAW and Explore 7.10, the licensing manager was updated to

work with the Thales Cloud licensing system. 

If you are installing LAW or Explore 7.9 or lower, then you will need Sentinel RMS

license Manager 8.6.0.

If you are installing LAW or Explore 7.10 or higher, then you will need Thales's

Sentinel RMS 10.2.0

Both can be found in the Software Download Center

Official CloudNine™ Software Download Center

A Knowledge Based Article on this subject can be found here: Installing the Sentinel RMS

License Manager (cloudnine.com)

Once you've downloaded the Sentinel Installer or the Thales Sentinel Installer, you are ready to

begin installing the Sentinel RMS License Server. The instructions below will guide you through

the installation process:

https://cloudnine.com/software-download/
https://cloudnine.com/software-download/
https://kb.cloudnine.com/installing-the-sentinel-rms-license-manager
https://kb.cloudnine.com/installing-the-sentinel-rms-license-manager
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NOTICE:  These instructions cover the installation of the Sentinel RMS License Manager on the local machine,

allowing this machine to be used as a License Server.

NOTE: Images for installing SafeNet Sentinel 8.6.0 are on the left and Thales Sentinel

10.2.0 are on the right

1. Start by running the Sentinel Installer "setup.exe" for either installer. Click Yes when

prompted to allow the app to make changes to your device. The InstallShield Wizard will

begin configuring the necessary prerequisites.

     

2. Once the necessary prerequisites have been configured, the InstallShield Wizard will bring

you to the Welcome screen. Click Next to proceed.

     

3. At the License Agreement screen, please read through the License Grant/Warranty. If you

agree to these terms, then select the radio button stating I accept the terms in the license

agreement, and click Next to proceed.
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4. At the Customer Information screen, you can change the User Name and/or enter an

Organization if desired, but leave the Install this application for option with the default

Anyone who uses this computer radio button selected. Click Next to proceed.

     

5. At the Destination Folder screen, review the install location shown before proceeding. You

can change this location by clicking the Change... button on the right. This will open the

Change destination folder window, allowing you to determine a new root folder (on this

computer) to use as the install location. If you choose a new folder, be sure to click OK to apply

those changes. When you're satisfied with the location shown, click Next to proceed.
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6. At the Setup Type screen, determine whether you would like a Complete or Custom install,

and select the appropriate radio button. A Complete install is recommended. Once you've

made your selection, click Next to proceed.
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7. Skip this step if you selected the Complete installation on the Setup Type screen. Otherwise,

at the Custom Setup screen, decide which features/programs you want to install by clicking

the icons on their left and selecting This feature will be installed on local hard drive from

the drop-down menu. Any feature/program with an X will not be installed. When you're

satisfied with the features/programs you've selected, click Next to proceed. This screen does

not exist for Thales Sentinel 10.2.0

8. At the Firewall Settings screen, review the necessary information regarding system firewalls.

It's recommended to leave the Unblock the system firewall for the Sentinel RMS License

Manager option enabled. Click Next to proceed.

     

9. At the Ready to Install screen, you have one last chance to go Back to any of the previous

screens and change the installation settings. Otherwise, click Install to begin the installation

process.



Detailed Checklist 51

© 2025 CloudNine™

     

10. You will be brought to the Installing Sentinel RMS License Manager screen, where the

installation progress is displayed. This process may take several minutes.

      

11. Once the installation finishes, you will arrive at the Completed screen. Click Finish to exit the

InstallShield Wizard.
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12. You have now finished installing the Sentinel RMS License Manager! At this point, you

should assign this machine as a License Server and activate your LAW Licenses on it, which

can be done through the License Manager utility from any LAW workstation. Instructions

covering this procedure can be found in the License Server topic.

See the 
License Server

 topic.

LAW Installer for License Manager UI

Though Thales Sentinel Software isn't owned by CloudNine, the UI for License Server

application is and it is built into the LAW application. 

For this part, you just need to install LAW on the licenses server, but you do not need to set it up.

The installers for LAW can be found here: Official CloudNine™ Software

Download Center

Once you've downloaded the LAW Installer, you are ready to begin installing LAW. The

instructions below will guide you through the installation process:

These instructions cover the installation of LAW and/or Explore on the local machine.

You can install them both at once, or separately as desired.

1. Start by running the LAW Installer as an administrator (right-click > Run as administrator).

Click Yes when prompted to allow the app to make changes to your device.

https://cloudnine.com/software-download/
https://cloudnine.com/software-download/
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2. You will first be greeted by the End User

License Agreement. If you agree to these

terms, then check the box stating I agree

to the license terms and conditions,

and click Install to proceed.

3. The LAW Installer now displays the

Setup Progress screen, which will remain

in place for the duration of the installation.

It will start automatically installing the

necessary prerequisites.



CloudNine™  LAW54

© 2025 CloudNine™

4. Once the necessary prerequisites are

installed, the Setup Wizard will open in

a separate window, and you will be

brought to the Welcome screen. Click

Next to proceed.

5. At the System Requirements screen,

review the information.  If the system

you are installing on meets the listed

requirements, select I acknowledge

that our environment meets the

system requirements and click Next to

proceed.  Please note if your system does

not meet the system requirements you

should click Cancel and discontinue the

installation.
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6. If you are following these steps to

install LAW for the Licenses Manger

then you will only need to install LAW.

You do not need the TIFF and PDF Printer

and Explore can be left out. You can also

then jump to step 11.

If you are building an all in one you

will need the LAW TIFF and PDF Printer

for LAW and CloudNine Explore if you

are installing for Explore.

At the Custom Setup screen, decide

which features/programs you want to

install by clicking the icons on their left

and selecting Will be installed on local

hard drive from the drop-down menu. Any feature/program with an X will not be installed.

   By default, LAW and the TIFF Printer Drivers are enabled for installation. CloudNine™ Explore is

not enabled for installation by default. 

The features available for installation are as follows: 

Feature Description Select for the use of

CloudNine

™ LAW

Installs LAW50.exe and related folders, system files,

templates, and utilities.

Needed to Install LAW

Needed to Install a

Licenses Server

CloudNine

™ Explore

Provides advanced prefiltering functionality. This feature

requires additional licensing to run. 

Needed to Install

Explore

TIFF / PDF

Printer

Drivers

A driver for batch printing, and for batch- and single-TIFF

conversion. Supports text extraction during TIFF

conversion. Installation is recommended. 

Also includes the LAW Image Driver 300 DPI Printer. This

is used to convert documents to TIFF at a resolution of 300

dots per inch. 

Needed if you want to

use the native batch

imager in LAW
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7. You can change the install location for all

programs/features selected within the

Custom Setup screen by clicking the

Browse... button to the far right of the

Location shown near the bottom. This

will open the Change destination

folder window, allowing you to

determine a new root folder (on this

computer) to use as the install location. If

you choose a new folder, be sure to click

OK to apply those changes.

8. You can also determine the hard drive

space is Required/Available for these

programs/features from the Custom

Setup screen by clicking the Disk Usage

button at the bottom-left. This will open

the Disk Space Requirements window,

indicating these details for all available

Volumes. When you're done reviewing

the information, click OK to close this

window.
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9. When you're satisfied with the features/programs and install location shown in the Custom

Setup screen, click Next to proceed.

10. Skip this step if

you're not installing Explore 

· At the Configure CloudNine Explore

Service screen, either enter a

o Microsoft Windows account (User

name and Password) that the

Explore Service will the run on.

o Enter or create an account in a

group that will allow the access

rights below.

o Full read/write/modify access to

share/location (source data and case folders), SQL, & any workstations.

o Add this account to SQL with db_owner role.

o User Names should be in this format (without angled brackets or quotations):  <"network

domain"\"network user name">

o Local System Account option from the Run As drop-down

o The current Windows user must have access permissions to the SQL Server, or you will be

unable to connect

11. At the Ready to install CloudNine

LAW screen, you have one last chance to

go Back to any of the previous screens

and change the installation settings.

Otherwise, click Install to begin the

installation process.
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12. You will be brought to the Installing

CloudNine LAW screen, where the

installation progress is displayed. This

process may take several minutes.

13. If you are following these steps to

install LAW for the Licenses Manger

then UNCHECK ‘Additional

configuration information is required to

complete the CloudNine LAW

installation.’ and click finish

If you are following these steps to

build an all-in-one then once the

installation finishes, you will arrive at the

Completed screen. If a License Server

has been assigned, and your License has

already been activated, then you are

ready to continue to the LAW

Configuration Utility, leave the option

on your screen checked. If your LAW license has not been activated on your license Server

uncheck this option before continuing. Click Finish to exit the Setup Wizard.
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14. The LAW Installer will now indicate that

the installation was Successfully

Completed. Click Close to exit the LAW

Installer.

15. You have now finished installing LAW! There are some additional steps we recommend you

take to ensure a fully functioning LAW experience:

1) Setting up the License Manager and activate your LAW Licenses here: 
License Manager

2) If you are building an all-in-one then you will need to configure your Environment

and/or Local Machine through the LAW Configuration Utility. Instructions can be found

in the 
LAW Configuration Utility

 topic.

3) If you are building a LAW workstation, have your system administrator grant all users

who will be running LAW full read/write/modify permissions to the root directory (install

location) for LAW. This ensures that their program settings/options are saved properly.

4) If you are building a LAW workstation have your system administrator adjust the

Properties of Law50.exe within the root directory (install location) of LAW to enable the

Run this program as an administrator option under the Compatibility tab. This will

prevent several known Windows related usability issues from occurring.

If you would like to create desktop shortcuts for LAW and CloudNine™ Explore, you can create

desktop shortcuts from the LAW and Early Data Analyzer .exe files. The Law50.exe file is located in

the ...\Program Files (x86)\Law50 directory, and the LAW.EdAnalyzer.exe file is located in the ...

\Program Files (x86)\Law50\EDAnalyzer64 directory. 
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License Manager

The current version of the License Manager can be found inside of the LAW install. i.e. to install the

License Manager install LAW. However, you do not need to set up LAW to work on the License

Server.

The Sentinel RMS License Manager must be installed on any computer operating as a License

Server, which may also be a LAW workstation if desired.

For instructions on installing the Sentinel RMS License Manager, refer to the

Sentinel Installer
 topic.

Once the Sentinel RMS License Manager has been installed on the intended License Server, you

are ready to activate your LAW Licenses on it. The instructions below will guide you through this

process:

NOTICE:  There are two ways to active a key,

First is over the internet. The license manager will call out to this website:
https://cloudnine.prod.sentinelcloud.com/.

Second Contact Customer Support to help with a Manual Activation

1. From any computer with LAW installed, launch the License Manager utility by clicking on

Start (Windows Key) > CloudNine LAW > License Manager from the Windows Taskbar.

2. Since the License Server has yet to be assigned, the Set

License Server window will automatically open. From here,

enter one of the following into the box provided:

a. The word "localhost" (without quotations) to assign this

computer as the License Server. Click OK to continue.

b. The name or network IP address of the computer assigned as the License Server. Click OK

to continue.

https://nam04.safelinks.protection.outlook.com/?url=https://cloudnine.prod.sentinelcloud.com/&data=05|02|jtucker@cloudnine.com|5fd02bf9e2bb495ef59708dda1d815fa|6cdec2cfa0b34e5cba0111153c5a0f92|0|0|638844671658585901|Unknown|TWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ==|0|||&sdata=dbl9pI6jtR03R9DlEbz+bJk610PUY1DjC0pPGKcr9Bw=&reserved=0
https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
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3. With a License Server now assigned, click on

the Activations button at the bottom-right to

open the Activations window. From here,

enter your Product Key (EID) into the

appropriate box at the top, and then click

Activate.

i. Please Contact Customer Support. to

help with a Manual Activation if you

do not have an internet connection.

4. Wait for the process to complete. When finished, a License

Manager dialog will appear, informing you of a successful

activation. Click OK to close it.

https://answercenter.ediscovery.co/litigation/ac/ac_portal/index.html?welcome.htm
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5. The Activations window

will automatically close,

and your software

Licenses will now appear

listed in the main License

Manager utility window.

The following

information is presented:

i. The License

Types that are

available, listed

under the License

column.

ii. The total number

of Seats provided

for each License Type, listed under the Total column.

iii. The number of available Seats remaining for each License Type, listed under the Free

column.

iv. The date that each License Type will expire, listed under the Expiration column. If

multiple copies of the same License Type are activated, then this column will display

the expiration date that comes first.

6. Repeat steps 3 and 4 for each additional Product Key (EID) that requires activation on this

License Server. When you're finished activating your Licenses, you can safely close the

License Manager utility.

7. It is recommended that you now configure your Environment and Local Machine for LAW

through the LAW Configuration Utility.

Instructions can be found in the 
LAW Configuration Utility

 topic.
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The Client button will show you 

Active Processing jobs all licenses that are currently in use by any workstation

accessing software licenses from the license server at the point in time that the

License Manager was opened or last refreshed.

Undock column references all licenses that are currently undocked by any

workstation accessing the software licenses from the license server at the point in

time that the License Manager was opened or last refreshed.

Viewing License Servers

You can change the current License Server being viewed/managed within the License Manager

utility by following these instructions:

1. From any computer with

LAW installed, launch the

License Manager utility

by clicking on Start

(Windows Key) >

CloudNine LAW >

License Manager from

the Windows Taskbar.
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2. The current License Server is displayed as a link in the top-left.

Click on this link to open the Set License Server window.

Depending on which License Server you are trying to

view/manage, enter one of the following into the box provided:

a. The word "localhost" (without quotations) if this machine is the desired License Server.

Click OK to confirm.

b. The machine name or network IP address of the desired License Server. Click OK to

confirm.

3. You are now ready to view or manage your available Licenses from this License Server.

Adding or Renewing Licenses

Please contact your sales representative to discuss any additions or renewals to your software

Licenses.

You can add new Licenses to a Product Key you've already been provided, or renew that key once

it has expired, through the Activations window of the License Manager utility.

Once you've made the necessary purchases, follow the instructions below:

1. From any computer with

LAW installed, launch the

License Manager utility

by clicking on Start

(Windows Key) >

CloudNine LAW >

License Manager from

the Windows Taskbar.
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2. Ensure that the correct License Server is displayed (link in the

top-left). This server should be hosting the Product Key (EID)

you are trying to renew or update. You can change servers by

clicking the link, which opens the Set License Server window.

From there, enter one of the following into the box provided:

a) The word "localhost" (without quotations) if this machine is the correct License Server.

Click OK to confirm.

b) The machine name or network IP address of the correct License Server. Click OK to

confirm.

3. Click on the Activations button at the bottom-

right to open the Activations window. From

here, do one of the following:

a) Adding Licenses:  Enter your Product

Key (EID) into the Product Key box at the

top, and then click Activate at the bottom-

right.

b) Renewing Licenses:  Select your Product

Key (EID) from within the Activated

licenses list, and then click the Refresh

button at the bottom-right.

In order for the "Refresh" button to

work, all licenses must be checked in.
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4. Wait for the process to complete. When finished, an appropriate

dialog window will appear, informing you of a successful addition

or renewal. Click OK to close it.

5. You can now safely close the Activations window and the License Manager utility.

The License Manager displays the LAW and/or CloudNine™ Explore license

information from the activated software product key(s). If more than one software

product key is activated on the license server, the License Manager displays the

combined license information from each of the software product keys currently

activated on the license server. 

When multiple EIDs are activated on the same license server with overlapping

features, the overlapping features will display the expiration date of the EID that

expires first. 

· For example, a perpetual EID contains 1 Tiff, 1 Admin, 1 ED Loader, and 1 OCR and

is activated on the license server with an expiration date of NEVER.  A burst license

for 2 Tiff licenses, 1 Edit, and 1 OCR licenses that Expires on 6/18/2018 is activated

on the same license server.  The license manager will display the 3 Tff and 2 OCR

licenses combined with an expiration date of 6/18/2018.

· Deactivating the burst license or the perpetual license from the license server to

activate on a different server, will remove all overlapping licenses.   For example,

deactivating the burst license will remove all Tiff and OCR licenses in addition to

the 1 Edit license, leaving the 1 Admin and 1 ED Loader on the license server.  The

current process is to deactivate the remaining license (perpetual EID) and activate it

again
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Manually Activating a Software Key

If you need to activate a software product key, but do not currently have an Internet connection on

the license server where the License Manager is installed, you can manually activate the software

product key. 

Contact the LAW Customer Support to manually activate a software product key. Provide the

software product key and the machine ID for the license server. Customer Support will generate and

send you a license file for activating the software product key on the license server. You can locate

the machine ID in the Manual Activation dialog box.

1. Open the License Manager on the license server by selecting Windows Start > All Programs >

CloudNine LAW > License Manager.

2. Click Activations.  The Activations

dialog box displays.
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3. Click the Manual Activation link.  The Manual

Activation dialog box displays.

The Machine Id box displays the machine ID for the

license server.

If you need to copy the machine ID, click the Copy

link.

4. Have your software product key and your machine ID ready, and then contact LAW Customer

Support at 713-462-6464 ext.12.

The Customer Support team will generate and provide you with a license file.

5. Save the license file to the license server where you will be activating the software product key.

6. In the Manual Activation dialog box, click the ellipsis button, ..., next to the License File box.

7. Clicking the ellipsis

button opens the Select

license file to activate

dialog box.
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8. Navigate to and click the license file.

9. Click Open.  The license file and path are added to the License File field.

10. Click Activate.  A "License(s) activated" message displays.

11. Click OK.

The License Manager displays the LAW and/or CloudNine™ Explore license information from the

activated software product key. If more than one software product key is activated on the license

server, the License Manager displays the combined license information from each of the software

product keys currently activated on the license server. 

View the License Information for Another License Server

 To View the License Information for Another License

Server

The License Server field in the License Manager dialog box indicates which license server license

information is currently being displayed in the License Manager dialog box. The License Server field

in the License Manager dialog box does not determine which license server is being used by LAW

and CloudNine™ Explore.

The 
Environment Licensing

 tab in the LAW Configuration Utility determines which license server is

used for CloudNine LAW. 

1. Open the License Manager on the license server.

To open the License Manager, click Start menu > All Programs > CloudNine LAW > License

Manager.

2. Click the License Server field link.

Clicking the License Server field link opens the Set License Server

dialog box.

3. In the License Server field, enter the machine name or IP address of the license server containing

the software product key information you want to view.

4. Click OK.

If you entered a valid license server, clicking OK opens the License server successfully set message.

5. Click OK.
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The license server you entered is displayed in the License Server field, and the license information

for the software product key(s) currently activated on the license server is displayed in the License

Manager dialog box.

 To View the List of Activated Software Product Keys

There are two places you can view the list of activated software product keys on a license server:

· License Manager. The Activated licenses list in the Activations dialog box displays every software

product key currently activated on the license server and the date and time each software product

key was activated.

· DataStore.xml file. When software product keys are activated in the License Manager, all activated

software product keys on the license server and the local dates and times the software product keys

were activated are stored in the DataStore.xml file in the following directory on the license server:

C:\ProgramData\LexisNexis\Litigation License Manager

The DataStore.xml file is automatically updated with the latest software product key activation

information from the License Manager.

Update or Refresh a Product Key

 Update Your Product Key

If changes have been made to your software product key, such adding additional licenses or

renewing the software product key, you can update your software product key by clicking the

Refresh button in the Activations dialog box. When the Refresh button is clicked, the License

Manager contacts the CloudNine servers over the Internet to get the latest updates for your

software product key(s). An active Internet connection is required to update software product keys

using the Refresh button.  

For the "Refresh" button to work, all licenses must be checked in.

1. Open the License Manager on the license server.
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To open the License Manager, click Start menu > All Programs > CloudNine LAW > License

Manager.

2. Click Activations.

Clicking Activations opens the Activations dialog box.

3. In the Activated licenses list, click the software product key you want to update.

4. Click Refresh.

When the software product key update is completed, the message License successfully refreshed. is

displayed.

5. Click OK to close the message.

6. In the Activations dialog box, click the close button, , to return to the License Manager

dialog box. 

7. In the License Manager dialog box, click the Refresh link above the Expiration column to display

the latest license information.

 To Refresh the License List in the License Manager 

The license information displayed in the License Manager dialog box is automatically refreshed each

time you open the dialog box or when you leave and return to the dialog box, such as when you

activate a software product key. 

You can also refresh the license information currently displayed in the License Manager dialog box

by clicking the Refresh link located above the Expiration column.

In rare cases you may need to deactivate all software licenses and reactivate to have

an accurate license count/ expiration date. 

Deactivating Licenses

You can deactivate Licenses from a Product Key through the Activations window of the License

Manager utility:
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1. From any computer with

LAW installed, launch the

License Manager utility

by clicking on Start

(Windows Key) >

CloudNine LAW >

License Manager from

the Windows Taskbar.

Ensure that the correct License Server is displayed (link in the top-

left). This server should be hosting the Product Key (EID) you are

trying to deactivate. You can change servers by clicking the link,

which opens the Set License Server window. From there, enter one

of the following into the box provided:

a) The word "localhost" (without quotations) if this machine is the correct License Server.

Click OK to confirm.

b) The machine name or network IP address of the correct License Server. Click OK to

confirm.
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2. Click on the Activations button at the bottom-

right to open the Activations window. From

here, select the unwanted Product Key (EID)

from within  the Activated licenses list, and

then click the Deactivate button at the

bottom-right.

For the "Deactivate" button to work,

all licenses must be checked in.

3. Wait for the process to complete. The Deactivate License dialog

window will appear, informing you of a successful deactivation.

Click OK to close it.

4. You can now safely close the Activations window and the License Manager utility.

Undock License

The purpose of an undocked license key is to temporarily hold licenses checked out from the license

server, so that licenses can be used on a second computer. A typical use of undock keys is to furnish a

laptop with the licenses necessary to conduct on-site discovery operations.

Undocked software licenses are generated from the License Manager, where you specify what licenses

to checkout and for how long. When the licenses are ready to be returned to the original license server,
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the licenses are reclaimed from the License Manager using the Reclaim Undocked menu selection. For

more information about the License Manager, see 
License Manager.

If an undocked license expires, it will still need to be reclaimed before continued use

on the workstation resumes.

 In version 6.18+ there is an option for undocking LAW and Near Dupe/Analytics using

software licensing.  CloudNine™ Explore, CloudNine™ Explore Web, Turbo Import, Turbo

Imager temporary licenses, and ELA   licensing are currently not available for undock

software licenses.

For more information see 
LAW Licensing

.

How to create a software undock license.

Undocked software licenses can be created in two ways.

· Undocked keys can be purchased from CloudNine allowing you to activate licenses that can then

be taken where ever you need to go. This solution does not need to start on an existing

environment.

Currently purchasing an undocked key from CloudNine is the only solution for Near

Dupe/Analytics using software licensing.  CloudNine™ Explore, CloudNine™ Explore

Web, Turbo Import, temporary licenses, and ELA licensing  are currently not available

for undocked software licenses.

· Undocked Softkey software licenses are generated from the License Manager, where you specify

which licenses to checkout and for how long. When the licenses are ready to be returned to the

original license server, the licenses are reclaimed from the License Manager using the Reclaim

Undock menu selection. 

Undock Soft Key

To undock a soft key to a computer/server/workstation that will house the undocked license that

computer/server/workstation must first be on the same network that that currently exist on. This new or

second server must be able to see the first server that is holding the license manager you want to

borrow from. 
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 Important Considerations before creating software undocked licenses notes.

 1. The computer that goes to the License Manager to create the undock license must be

the one to be used off-site.

 2. Once the undock license is generated it cannot be moved to another computer; the only

option is to reclaim it (returning it to the license server).

 3. It is recommended to Reclaim Undocked licenses prior to checking out new undocked

licenses and after completing off-site work.  

1. Open the License Manager on the computer that will be used off-site.

Windows 10

To open the License Manager, click Windows Icon > CloudNine LAW > License

Manager.

2. Enter in the name of the server with your current License

Manager. The License Manager on your second server will then

open and display the licenses that are currently on that first license

server you want to borrow from. 

2. Select the Undock button.

3. The Select Licenses to Undock window will then open in

a new window.
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4. Select all the desired licenses that the workstation will need for the off-site project.  

Only one of each license can be selected.  The licenses are checked out to that

workstation only.  The workstation with the undocked licenses does not function as a

license server and does not share the licenses that are undocked.

5. Expiration Date: enter the date that you would like the undocked licenses to automatically expire or

select the calendar icon  and choose the date. The date must be past the current date.

 Some points to remember when selecting the expiration date:

 •The license must be checked out for longer than one day.  For example, if today is April

13th then the license(s) must be checked out until the 14th of April at the earliest.

 •The licenses are not valid after the subscription expiration.

 •If you have multiple subscription expiration dates then each undocked license will have

an expiration based on that license's expiration date.

6.  Select OK to check out the selected licenses.

7.  The Licenses undocked successfully window will open if all of the

selected licenses were successfully checked out.
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8. LAW will now open with the

set of licenses that were checked

out
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 Some possible Undocking Results:

 Success - The individual license was successfully

checked out.

 Success - Note: This license can be undocked

only until (subscription expiration date).

 Unsuccessful - This license is already undocked for this

machine.  You have previously undocked this license

and not reclaimed it prior to selecting it again.

 Unsuccessful - All licenses are in use.  All licenses of

this license type are in currently in use or already

checked out to undocked keys.

 Undock failed because of expiration date - The expiration date was set earlier than

tomorrow's date.

8.  To return the undocked licenses to the license server see below.

9.  To view licenses currently undocked go to open the original license manager and click on Clients.

If an undocked license expires, it will still need to be reclaimed before continued use

on the workstation resumes. 

Undocked licenses can only be reclaimed from the workstation that created the

undocked license.
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Using a software undock license.
After creating an undocked license, from the computer that will be using the undocked license(s), launch

CloudNine™ LAW.

LAW will open to the main screen of LAW, the features checked out to the undocked license will be

available for use.

If you are needing additional features, you will need to either reclaim your undocked licenses and

undocked all features again, or undocked additional features.

All undocked licenses will Expire at midnight on the day that they were set to expire.  The undocked

licenses must be reclaimed before using licenses from the license server or temporary licenses.

When going to Help> About CloudNine™ LAW> Licenses> the undocked licenses will be displayed and

the earliest expiration date if you have multiple undocked licenses with multiple expiration dates.

How to reclaim a software undock license

A Knowledge Based Article on this subject can be found here: How do I undock and reclaim

software license keys? (cloudnine.com)

To return the undocked licenses to the license server, you must log into the License Manager from the

computer that undocked the licenses.

1. Open the License Manager on the license server.

Windows 10

To open the License Manager, click Windows Icon  > CloudNine LAW > License

Manager.

2.Select Reclaim Undocked.

3.  The licenses that were undocked using this workstation will be available under Free.

If an undocked license expires, it will still need to be reclaimed before continued use

on the workstation resumes.

If you don't want to use the Undocking workflow, you can install the Licenses

Manager anywhere you would like. Then use the LAW Configuration Utility to point

the workstation to that Licenses Server

https://kb.cloudnine.com/how-do-i-undock-and-reclaim-software-license-keys
https://kb.cloudnine.com/how-do-i-undock-and-reclaim-software-license-keys


CloudNine™  LAW80

© 2025 CloudNine™

LAW Profile Manager

The LAW Profile Manager is the utility used for managing licenses. The licensing type you are using

for LAW determines which functionality is available in the LAW Profile Manager.

All licenses are maintained in a software product key on the license server. A license server is where

a software product key is activated.

You can use the LAW Profile Manager to perform the following tasks:

· Connect to a license server for CloudNine™ LAW

· Add, edit, and delete custom license profiles for LAW

· Monitor usage and availability of licenses 

 To Start the LAW Profile Manager

· Click Start, point to All Programs, point to CloudNine LAW, and then click Profile Manager.

 To Create or Change a Password

To create a password for the first time on a computer:

1. Click Start, point to All Programs, point to CloudNine LAW, and then click Profile Manager.

2. Click Advanced.

· A prompt to enter an administrative password appears. The password is stored at a

workstation level, meaning each computer on which LAW is launched, whether running

locally or in a client/server configuration, will prompt for a password when executed initially.

3. In the Enter Admin Password dialog box, type a case-sensitive password that is at least 6

characters long and then type it again to confirm. 

4. Click OK. 

To change the password on a computer:

1. Click Start, point to All Programs, point to CloudNine LAW, and then click Profile Manager.
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2. Click Advanced.

· If you are not in administrative mode, the Enter Password dialog box appears.

3. Type the current administrative password and then click OK. 

4. On the Tools menu, click Change Administrative Password.

· Clicking Change Administrative Password opens the Change Admin Password dialog

box.

5. In the Enter new password field, type a case-sensitive password that is at least 6 characters long,

and then type it again in the Confirm Password field. 

6. Click OK. 

A prompt for a password after clicking Advanced means that you are not running the

LAW Profile Manager in administrative mode. For more information, see the To

switch to Administrative Mode section in this topic.

 To Use a Temporary License in CloudNine LAW 

When a temporary license is in use, the LAW Profile Manager dialog box is not displayed

when starting the LAW application.

· To active a Temporary licenses, use the Licenses Manager just like you would with any

other licenses. 

 To Connect to a License Server 

1. Setting the license server in  
Configure Environment

 in the LAW Configuration Utility needs to be

done prior to launching LAW.  

· If a valid license server computer name has been entered, the LAW Profile Manager dialog

box opens. 

· If a license key is not found on the specified server, a message will appear stating that the key

was not found and will ask to try another server. If this happens click Yes, and then follow the

prompts to change the license server. 
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 To Select Licenses by Using a License Profile 

Each time you start LAW, instead of selecting licenses singly, you can load a license profile. 

1. Start the LAW Profile Manager.

2. Check out licenses by means of a license profile by

selecting one of the following: 

· <Any Available Licenses> Checks out one of each

available license. These licenses will not be available to

other workstations using the same license key. 

· <Custom> You can check out specific licenses based

on their tasks. For example, if you need to scan

documents, you can select just the Scan license. Click

OK to open the list of licenses.

· User defined. Any user-defined license profile is listed

below the two system profiles. To create a user-

defined license profile, see the next section in topic call

To Create Custom Profiles.

3. Select the licenses needed for the session and then click OK. 

· Only the selected licenses are checked out and available on that workstation. If one or more

license modules cannot be checked out, a message box appears stating which licenses could

not be acquired. 

 To Create Custom Profiles 

1. Start the LAW Profile Manager. 

2. Click Add.

· If the Add button is grayed out, switch to administrative mode to enable it. On the File menu,

click Switch to Administrative Mode and then enter and confirm the password, click OK

twice and then click Add. 

3. In the Add New Profile dialog box type the name of the new profile and a description.
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4. Select the licenses to include in the profile. 

5. To set this profile as the default profile for the current user, select Default Profile. 

6. Click OK. 

· The new license profile is displayed in the LAW Profile Manager dialog box. If selected as

the default profile, it is automatically highlighted.

7. To automatically check out licenses and bypass the LAW Profile Manager, select the profile as the

default profile. Then deselect Prompt for profile when starting LAW in the LAW Profile

Manager dialog box. 

To re-enable the setting that automatically opens the LAW Profile Manager, set

Prompt=1 in the profman.ini file in <application path>\ProfMan. The section in the

INI file containing this setting is in the following format: [<user name>].

 To Hide the System Profiles 

Hiding a profile can be useful to safeguard against inadvertently selecting the wrong profile. For

example, the LAW Profile Manager populates the Profiles area with two system profiles <Any

Available Licenses>, and <Custom>. To prevent users from checking out more licenses than

needed, these profiles may be hidden. 

1. Start the LAW Profile Manager. 

2. Click File, and then click Switch to Administrative Mode. Enter the administrative password,

click OK, and then OK again. 

3. Right-click the system profile to hide and then click Hide System Profile.

 To Restore the System Profiles

· Right-click anywhere in the Profile area and then click Restore Hidden Profiles. 
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 About Administrate Mode

You must switch the LAW Profile Manager to administrative mode before you can perform

several administrative functions, such as working with licenses and working with profiles. 

One way to switch to administrative mode is to start the LAW Profile Manager, and then, on the

File menu, click Switch to Administrative Mode and then type the administrator password.

Alternatively, there are many features that require you to provide the administrator password

before continuing. Switching to administrative mode enables you to: 

· Add, edit, and delete profiles.

· Refresh licenses to add any newly purchased licenses to the software product key.

· Enter the advanced view of the LAW Profile Manager.

· Hide/restore system profiles.

 To Switch to Administrative Mode

1. Click Start, point to All Programs, point to CloudNine LAW, and then click Profile Manager.

· The LAW Profile Manager dialog box appears. 

2. Click File and then click Switch to Administrative Mode.  The Enter Password dialog box

appears.

3. Type the administrative password and then click OK. 

· Clicking OK opens the Successfully switched to administrative mode message.

4. Click OK. 

 To Configure Administrative Details

1. Click File and then click Switch to Administrative Mode.  The Enter Password dialog box

appears.
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3. Type the administrative password and then click OK.

· Clicking OK opens the Successfully switched to administrative mode. message.

4. Click OK.   

5. Click Advanced. 

· The LAW Profile

Manager searches for

the license servers.

· The LAW Profile

Manager

(Administrative

Mode) dialog box

appears.

6. Use the following menu commands to configure the administrative mode of the LAW Profile

Manager:

Use the When you want to

File menu · Refresh the view of profiles.

· Refresh the view of available license servers.

Profile menu · Add, edit, and delete profiles.

· Set a profile as the default.

Server Key

menu

· Change the license server.

· Refresh the view of license counts when new licenses have been purchased

and added to the existing software product key.
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Use the When you want to

The Server Key menu is enabled when you click Software License, a license

server, or a license key under License Servers in the LAW Profile Manager tree

view.

Tools menu · Change the administrative password.

· Disable or enable automatic refresh of the view of network server keys. This

option is controlled by the Enable LAW license server enumeration

setting, which is enabled by default. 

Profiles tree · Add, edit, and delete custom profiles.

· View details about all profiles stored on the current computer, as well as the

two default license selection methods (<Any Available License> and

<Custom>). When a profile is selected, the right pane will display the name,

description, and licenses stored in that particular profile.

License

Servers tree

View details about the current license server. 

Software License is displayed under License Servers and the license server's

computer name is displayed under Software License.

The LAW Profile Manager columns provide the following information:

· License. Lists each type of LAW license. 

Licenses that do not exist on the product key are listed, but 0 is displayed in

the Total, In Use, and Free columns for the license.

· Total. Displays the total number license seats for each type of license.

· In Use. Displays the number of license seats in use for each type of license.

· Free. Displays the number of available license seats for each type of license.

 To Acquire or Release Licenses From CloudNine LAW

To avoid closing LAW and launching the LAW Profile Manager, to change the selection of license

modules, licenses can be checked out and released from within the LAW application. 
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1. In LAW on the Help menu, click About

CloudNine LAW, and then click Licenses.

· The License Information dialog box

appears.

· In the Active Key area, the Server Name

field displays the license server name. The

Serial No. field displays SOFTWARE LICENSE

for software key licensing and the product

key expiration date(s) (if applicable). 

· The Licenses area displays the LAW licenses.

When a license's check box is selected, it

means the license is currently checked out. If

a license name is grayed out, the product key

does not contain this license.   

2. Perform one of the following: 

· To acquire a license, select the license's check box. A message box will appear indicating

whether license acquisition was successful. 

· To release a license, clear the license's check box. No message box will appear. 

· At least one license must remain checked out while LAW is running. 

· If the OCR license is released, OCR Add-on (PDF) will be automatically released

because it also depends on the OCR license.
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Installing CloudNine LAW

The following sections provide the steps required to install CloudNine™ LAW, TIFF printer drivers,

and Sentinel RMS License Manager. If you are installing CloudNine™ LAW, these instructions

assume that you are installing on a computer that meets or exceeds the 
system requirements

 of

CloudNine™ LAW. 

The LAW installer can be downloaded from CloudNine.  CloudNine's software download site is

HERE

By default, LAW and Explore are installed in the ...\Program Files(x86)\LAW50\ directory.

https://cloudnine.com/software-download/#:~:text=Prior%20to%20download,%20please%20visit%20the%20CloudNine%20Answer%20Center
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LAW Installer

The installers for LAW and Explore are packaged into a single executable file known as the LAW

Installer. You can obtain this installer from the link below:

Official CloudNine™ Software Download Center

A Knowledge Based Article on this subject can be found here: Installing LAW (cloudnine.com)

Once you've downloaded the LAW Installer, you are ready to begin installing LAW. The

instructions below will guide you through the installation process:

These instructions cover the installation of LAW and/or Explore on the local machine.

You can install them both at once, or separately as desired.

1. Start by running the LAW Installer as an administrator (right-click > Run as administrator).

Click Yes when prompted to allow the app to make changes to your device.

2. You will first be greeted by the End User

License Agreement. If you agree to these

terms, then check the box stating I agree

to the license terms and conditions,

and click Install to proceed.

https://cloudnine.com/software-download/
https://kb.cloudnine.com/installing-law
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3. The LAW Installer now displays the

Setup Progress screen, which will remain

in place for the duration of the installation.

It will start automatically installing the

necessary prerequisites.

4. Once the necessary prerequisites have

been installed, the Setup Wizard will

open in a separate window, and you will

be brought to the Welcome screen. Click

Next to proceed.
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5. At the System Requirements screen,

review the information.  If the system

you are installing on meets the listed

requirements, select I acknowledge

that our environment meets the

system requirements and click Next to

proceed.  Please note if your system does

not meet the system requirements you

should click Cancel and discontinue the

installation.

6. At the Custom Setup screen, decide

which features/programs you want to

install by clicking the icons on their left

and selecting Will be installed on local

hard drive from the drop-down menu.

Any feature/program with an X will not

be installed.

   By default, LAW and the TIFF Printer

Drivers are enabled for installation.

CloudNine™ Explore is not enabled for installation by default. 

The features available for installation are as follows:



CloudNine™  LAW92

© 2025 CloudNine™

 

Feature Description Select for the use of

CloudNine

™ LAW

Installs LAW50.exe and related folders, system files,

templates, and utilities.

Needed to Install LAW

Needed to Install a

Licenses Server

CloudNine

™ Explore

Provides advanced prefiltering functionality. This feature

requires additional licensing to run. 

Needed to Install

Explore

TIFF / PDF

Printer

Drivers

A driver for batch printing, and for batch- and single-TIFF

conversion. Supports text extraction during TIFF

conversion. Installation is recommended. 

Also includes the LAW Image Driver 300 DPI Printer. This

is used to convert documents to TIFF at a resolution of 300

dots per inch. 

Needed if you want to

use the native batch

imager in LAW

7. You can change the install location for all

programs/features selected within the

Custom Setup screen by clicking the

Browse... button to the far right of the

Location shown near the bottom. This

will open the Change destination

folder window, allowing you to

determine a new root folder (on this

computer) to use as the install location. If

you choose a new folder, be sure to click

OK to apply those changes.
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8. You can also determine how much hard

drive space is Required/Available for

these programs/features from the

Custom Setup screen by clicking the

Disk Usage button at the bottom-left.

This will open the Disk Space

Requirements window, indicating these

details for all available Volumes. When

you're done reviewing the information,

click OK to close this window.

9. When you're satisfied with the features/programs and install location shown in the Custom

Setup screen, click Next to proceed.

10. Skip this step if

you're not installing Explore 

· At the Configure CloudNine Explore

Service screen, either enter a

o Microsoft Windows account (User

name and Password) that the

Explore Service will run on.

o Enter or create an account into a

group that will not hinder the

access rights below.

o Full read/write/modify access to

share/location (source data and case folders), SQL, & any workstations.

o Add this account to SQL with db_owner role.
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o User Names should be in this format (without angled brackets or quotations):  <"network

domain"\"network user name">

o Local System Account option from the Run As drop-down

o Then the current Windows user must have access permissions to the SQL Server, or you

will be unable to connect

11. At the Ready to install CloudNine

LAW screen, you have one last chance to

go Back to any of the previous screens

and change the installation settings.

Otherwise, click Install to begin the

installation process.

12. You will be brought to the Installing

CloudNine LAW screen, where the

installation progress is displayed. This

process may take several minutes.
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13. Once the installation finishes, you will

arrive at the Completed screen. If a

License Server has been assigned, and

your License has already been activated,

you are ready to continue to the LAW

Configuration Utility. Leave the option

on your screen checked. Otherwise, you

will need to activate your License on a

License Server before you can correctly

configure LAW. Uncheck this option

before continuing. Click Finish to exit the

Setup Wizard.

14. The LAW Installer will now indicate that

the installation was Successfully

Completed. Click Close to exit the LAW

Installer.

15. You have now finished installing LAW! There are some additional steps we recommend you

take to ensure a fully functioning LAW experience:
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1) Activate your LAW Licenses through the License Manager utility if you haven't already

done so. Instructions for doing so can be found in the 
License Server

 topic.

2) Configure your Environment and/or Local Machine through the LAW Configuration

Utility. Instructions can be found in the 
LAW Configuration Utility

 topic.

3) Have your system administrator grant all users who will be running LAW full

read/write/modify permissions to the root directory (install location) for LAW. This ensures

that their program settings/options are saved properly.

4) Have your system administrator adjust the Properties of Law50.exe within the root

directory (install location) of LAW to enable the Run this program as an administrator

option under the Compatibility tab. This will prevent several known Windows related

usability issues from occurring.

If you would like to create desktop shortcuts for LAW and CloudNine™ Explore, you can create

desktop shortcuts from the LAW and Early Data Analyzer .exe files. The Law50.exe file is located in

the ...\Program Files (x86)\Law50 directory, and the LAW.EdAnalyzer.exe file is located in the ...

\Program Files (x86)\Law50\EDAnalyzer64 directory. 

Silent Installations

Sentinel RMS License Manager is installed separately from LAW.  When configuring LAW, you

will need to make sure you have access to your License Server and that you have a valid LAW

License.

 

 Performing a Silent Install

When you need to install the full version of CloudNine™ LAW, including CloudNine™ Explore, on

numerous machines, you can save time by running Silent Installations of LAW and Explore.

Silent Installations install applications without prompting for input during the installation.

1. Open a Command Prompt window by typing "cmd" in the Windows Search box and then

selecting Run as administrator. 

2. Determine which version of LAW you wish to install, and note the name of the associated

installation executable.  This name becomes the <installation executable> portion of the

command line.

i. For example, the installer for LAW 7.4 is named "law_full_7.4.58.exe" (without

quotations).
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3. Determine which features you want to install.  Features are added as a comma-delimited list

(no spaces, and feature names are case-sensitive), becoming the <feature list> portion of the

command line.

i. For example, to install all available features, your <feature list> would be

"LawApplication,LAWPrinterDrivers,ExploreApplication" (without quotations).

Features available for installation:

· LawApplication - Installs the CloudNine™ LAW application.

· LAWPrinterDrivers - Installs the TIFF Print Drivers.

· ExploreApplication - Installs the CloudNine™ Explore application and service.

4. Enter the following in the Command Prompt window, replacing the <installation executable>

and <feature list> with the values you determined in Steps 2-3:

<installation executable> /s /qn ADDLOCAL=<feature list>

5. Press ENTER in the Command Prompt window to run the silent installation on the machine.



CloudNine™  LAW98

© 2025 CloudNine™

LAW Configuration Utility

The LAW Configuration Utility is used to establish access to various resources and services that

LAW requires to operate properly.

There are two different sets of configurations provided within this utility:

· Environment - Establishes the database and Licensing resources to be used by all LAW

workstations. Must be run at least once on any computer in a shared or local environment.

· Local Machine - Provides database access to individual LAW workstations, and allows each

workstation to participate in shared Turbo Import processing (Agent services). Must be run

locally on each computer.

Once you've successfully installed LAW, and your software Licenses have been activated on a

License Server, then you are ready to begin configuring LAW:

1. Launch the LAW Configuration Utility by clicking on Start (Windows Key) > CloudNine

LAW > LAW Configuration Utility from the Windows Taskbar.

2. At the main Welcome screen,

choose one of the following options

based on your current situation:

1) If this computer is not part of a

shared environment, or is the

first computer in a shared

environment on which LAW is

being configured (after

installing/upgrading), then click

on Configure Environment in

the bottom-left. Proceed to the

Configure Environment
 topic.

2) If the shared or local

environment has already been

configured, and/or this

workstation needs to participate in Turbo Import processing, then click on Configure

Local Machine in the bottom-right. Proceed to the 
Configure Local Machine

 topic.
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Configure Environment

This section of the LAW Configuration Utility covers the necessary database and Licensing

configuration that affects all workstations running LAW in a shared or local environment.

At any time during configuration, you can use the Back and/or Next buttons at the bottom-right of

the utility to either return to a previous step, or proceed to the next one.

Each step is named after the section it references, and provides it's own set of instructions. You can

return to this page for future reference if any changes need to be made to your LAW Environment.

Steps/Sections:  
Management DB

 
Case List Migration

 
Default Paths

 
Licensing

File Type DB
 

NIST
 

Review

1. Management DB Configuration:

A. Enter the SQL Server Name with

the SQL Server Instance Name

(ex: SQL\name) to be used by

all LAW workstations, along with

user credentials (User Name and

Password) for this server. A

database will be created for LAW

on this SQL Server.

i. The SQL Server Name

can be either the server's

machine name with

instance name or IP

address.

ii. The SQL Database Name

shown is the name of the database being created on that server, defaulting to

"LAW5_Management".

iii. You can select Use Windows Authentication to automatically apply your current

Windows login information as the user credentials instead (no input necessary).
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iv. If not selected, then SQL authentication is used and a User Name and Password

needs to be provided. The user name law_user and associated password is provided

by default.

If desired, you can use SQL authenticated custom logins.  See

Adding SQL Server custom logins to existing databases
 for more information.

If you use the Local System Account to run the 
LAW Service

, then you should use

law_user (SQL Login) for the Management and File Type databases. Running the Local

System Account in tandem with Windows Accounts for Management and File Type

database logins may prevent LAW from correctly processing documents.

B. Click Test Connection to ensure that the server details are correct. If the test fails, a

prompt will appear indicating any issues.

C. When you see Connection Test Succeeded, you are ready to proceed. Click Next to

continue.

2. Case List Migration Configuration:

The Case List (MDB file) is used to

record the name and file path for

all Case Files that have been

opened or created in LAW. This list

can be migrated from previous

LAW installations, and will be

stored on your SQL Server

Database.

A. Perform one of the following,

depending on the needs of your

current LAW Environment:

1) If you have a Case List from a

previous installation of LAW

that you would like to use in

this Environment, then click on Select Case List to navigate to the desired MDB file

and select it.

2) If you don't already have a Case List, or wish to use a new one for this Environment,

you can leave the default MDB file as selected, then click next to skip the process.
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B. With your Case List now selected, you are ready to proceed. Click Next to continue.

3. Default Paths Configuration:

NOTICE:  It's recommended

to use UNC paths for all

shared network locations.

A. Enter a Case Folder

network/local path for LAW to

use as its Case File storage

location. You can also click

Browse... on the right to navigate

to a location and select it via a

File Explorer.

i. For shared network drives

(i.e. a mapped drive),

ensure that the path

selected is identically mapped for all workstations running LAW. These locations are

not recommended for Turbo Import cases.

B. Enter an Image Folder network/local path for LAW to use as its image file storage location.

You can also click Browse... on the right to navigate to a location and select it via a File

Explorer.

C. Click Validate Paths to ensure that shared network locations can be accessed correctly.

This step is not necessary for local paths.

D. When you are ready to proceed, click Next to continue.
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4. Licensing Configuration:

A. Enter one of the following,

depending on which computer is

being used as your License

Server:

1) The word "localhost" (without

quotations) if this computer is

your License Server.

2) The name or network IP

address of the computer that

is your License Server.

B. Click Test Connection to ensure

proper connection with your

License Server. If the connection

fails, a prompt will appear indicating any issues.

C. When you see Connection Test Succeeded, you are ready to proceed. Click Next to

continue.
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5. File Type DB Configuration:

You can import a File Type

Management database from a

previous LAW installation, or a new

one will be created automatically.

A. Perform one of the following,

depending on the needs of your

current LAW Environment:

1) If you're not using a previous

FTM database, then leave the

SQL Server Name and user

credentials (User Name and

Password) exactly as they

appear. This information

should automatically match

what was entered on the Management DB step. A new FTM database will be created

automatically using SQL Database Name displayed. You can change this name if

desired, or leave it at the default "LAW_FTM". Ignore the FTM not loaded warning

message.

NOTICE:  If you accidentally changed any of the SQL Server details, you may be

required to click Test Connection again to ensure proper connection with the SQL

Server before being able to proceed.

2) If you are using a previous FTM database, then enter the SQL Server Name and user

credentials (User Name and Password) for the server on which the database is located,

along with the SQL Database Name of that FTM database. Click Test Connection to

ensure that the FTM is loaded properly (as will be indicated). You can also click Import

FTM instead to navigate to the desired FTM database file and select it.

B. When you are ready to proceed, click Next to continue.
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6. NIST Configuration:

This step is optional, and only

needs to be completed if NIST

filtering will be applied when

importing documents. You can

import a NIST database from a

previous LAW installation, or create

a new one here.

Starting with LAW 7.12 we

can convert the RDSv3

formatted NIST list, in a SQL

database. It is

recommended that you use

the Modern RDS

(minimal). It is optional to

add Android RDS, iOS RDS.

When you are loading a

NIST database, keep it in the

.ZIP format and navigate to

the folder. 

You will also want 200gb

of free space on the C

drive available to convert

and load the NIST list.

A. Enable the Configure NIST Database option by checking the box on the left.

B. Perform one of the following, depending on the needs of your current LAW Environment:

1) If you're not using a previous NIST database, then leave the SQL Server Name and

user credentials (User Name and Password) exactly as they appear. This information

should automatically match what was entered on the Management DB step. Click

Load NIST Data and follow the instructions in the Load NIST Data window to

download and apply the appropriate NIST files. A new NIST database will be created

with these files, using SQL Database Name displayed. You can change this name if

desired, or leave it at the default "LAW_NIST".

2) If you are using a previous NIST database, then enter the SQL Server Name and user

credentials (User Name and Password) for the server on which the database is located,

along with the SQL Database Name of that NIST database.
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C. Click Test Connection to ensure that the NIST database files are properly loaded. If the

test fails, a prompt will appear indicating any issues.

D. When you see NIST is loaded, you are ready to proceed. Click Next to continue.

7. Review Settings:

A. Take this chance to review all the

configuration settings being

applied to your LAW

Environment. If something

needs changed, you can go Back

to any previous step and make

the necessary corrections.

B. If everything looks good, click

Finish to apply these settings,

and create the necessary

databases on your SQL Server.
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8. Configuration Results:

A. Click one of the following, depending on

whether or not you plan to use this

computer for Turbo Import document

processing:

1) If YES to Turbo Import setup on this

computer, continue to

Configure Local Machine: Service
.

2) If NO, then the LAW Configuration

Utility closes, and you are now finished

configuring LAW!

Configure Local Machine

This section of the LAW Configuration Utility covers the necessary database and Turbo Import

service accessibility for each workstation running LAW in a shared or local environment.

At any time during configuration, you can use the Back and/or Next buttons at the bottom-right of

the utility to either return to a previous step, or proceed to the next one.

Each step is named after the section it references, and provides it's own set of instructions. You can

return to this page for future reference if any changes need to be made to your LAW Local

Machine.

Steps/Sections:  
Roles

 
Management DB

 
Service

 
Review
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1. Roles Configuration:

· Determine which of the available

Roles this computer should have

when running LAW. It is

recommended to leave both

options selected.

i. LAW Workstation.  If

selected, this local

machine will be

configured as a LAW

Workstation.  This option

is selected by default.  This

selection is required in

order for LAW to open on

this machine.

ii. LAW Service.  If selected, this local machine can serve as a "worker" box for Turbo

Import processing. This is the button to allow a workstation to run Turbo jobs.

To utilize Turbo Import at least one installation of CloudNine™ LAW should have LAW

Service (Windows Service) also installed and active/running.   If there are no instances

of LAW Service configured within your environment then Turbo Import will be in a

Work Pending state indefinitely.

· When you are ready to proceed, click Next to continue.
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2. Management DB Configuration:

· Enter the SQL Server Name and

user credentials (User Name and

Password) for the SQL Server

that was selected while

configuring your LAW

Environment.

i. If you have not yet

configured your LAW

Environment (required),

then do so now before

continuing. Click Back

twice to return to the main

LAW Configuration

Utility, and then select

Configure Environment

instead.

ii. If selected, windows authentication is enabled and the current windows login will be

used to connect to the database.  The windows login must be listed under SQL

security logins and have the necessary permissions to that database.  

iii. If not selected, then SQL authentication is used and a User Name and Password

needs to be provided. The user name law_user and associated password is provided

by default.

If desired, you can use SQL authenticated custom logins.  See Adding SQL Server

custom logins to existing databases  for more information.

· Click Test Connection to ensure that the server details are correct. If the test fails, a

prompt will appear indicating any issues.

· When you see Connection Test Succeeded, you are ready to proceed. Click Next to

continue.

If you use the Local System Account to run the LAW Service, then you should use

law_user (SQL Login) for the Management and File Type databases. Running the Local

38
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System Account in tandem with Windows Accounts for Management and File Type

database logins may prevent LAW from correctly processing documents.

3. Service Configuration:

If you didn't select to have this

Local Machine as part of the LAW

Turbo Pool, then this page will be

skipped during the configuration. 

· Perform one of the following,

depending on where the Default

Paths for your LAW

Environment are located:

1) If the paths point to a shared

network device, then enter the

user credentials or Microsoft

Windows Account (User

Name and Password) used

to access that device. Click

Validate Input to ensure a proper connection.

o If you need to create a Windows Account

o Enter or create an account into a group that will not hinder the access rights below.

o Full read/write/modify access to share/location (source data and case folders), SQL, &

any workstations.

o Add this account to SQL with db_owner role.

i. User Names should be in this format (without angled brackets or quotations): 

<"network domain"\"network user name">

2) If the paths point to a location on this computer (local), then instead select Local

System Account from the Run service as drop-down menu at the top.

o Then the current Windows user must have access permissions to the SQL Server,

or you will be unable to connect

· When you are ready to proceed, click Next to continue.
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4. Review Settings:

· Take this chance to review all the

configuration settings being

applied to your Local Machine.

If something needs changed, you

can go Back to any previous step

and make the necessary

corrections.

· If everything looks good click

Finish to apply these settings.

5. Configuration Results:

· Click OK to close the LAW

Configuration Utility.
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6. You are

now

finished

configuring

your Local

Machine

for LAW! If

this

computer

was setup

for Turbo

Import, it is

recommen

ded to take

the

following

action:

· Check this computer's Windows Services to ensure that the LAW Service is running

properly.
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LAW Workstation Considersations

Install All Microsoft Language Packs
 

Turn off the Caching of Thumnails
 

Show Hidden Files and File Extensions 

Lower User Account Control Settings to 'Never Notify'

Install All Microsoft Windows Language Packs – 

For support with associated

Unicode characters, it is

suggested that all Windows

Language Packs be loaded onto

images. This site can help walk

you through the process:

Language packs for Windows

(microsoft.com)

· Select

the Start b

utton, and

then

select Setti

ngs > Time

&

Language

>

Language 

· Under Preferred languages, select Add a language.

· Under Choose a language to install, select or type the name of the language that you want to

download and install, and then select Next.

· Under Install language features, select the features that you want to use in the language that you

selected to download, and then select Install.

Turn off the Caching of Thumbnails in Hidden thumbs.db

files:

https://support.microsoft.com/en-us/windows/language-packs-for-windows-a5094319-a92d-18de-5b53-1cfc697cfca8
https://support.microsoft.com/en-us/windows/language-packs-for-windows-a5094319-a92d-18de-5b53-1cfc697cfca8
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How to

Disable/Remove

Thumbs.db File on

Network Folders in

Windows? | Windows

OS Hub

(woshub.com)

To prevent

Windows File

Explorer from

creating a

hidden

thumbnail

cache

(Thumbs.db

file) when browsing folders, you can use a GPO.

1. Run the local GPO editor (gpedit.msc) or create a domain GPO using

the gpmc.msc console.

2. Go to the following Group Policy section User Configuration -

> Administrative Templates -> Windows Components -> File Explorer.

3. This section has three options that allow you to manage the creating of the

thumbs.db file by File Explorer:

§ Turn off the display of thumbnails and only display icons on network

folders (prevents thumbs.db file from being created on shared network folder)

§ Turn off caching of thumbnails in hidden thumbs.db files

§ Turn off the display of thumbnails and only display icons

4. Enable all three policies by changing their values to ‘Enabled’;

It remains to link the Group Policy to users (if you use domain GPOs) and update it on

domain computers. To apply the policy settings immediately, run the

command: gpupdate /force

Show Hidden Files and File Extensions 

This will vary

by Operating

System. For

Windows 10

you can access this by opening an Explore Window > Click View and you will see ‘File name

extensions’ and ‘Hidden items’. Turn these options on.

http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/disable-creating-thumbs-db-on-network-folders/
http://woshub.com/update-group-policy-settings-windows
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Lower User Account Control Settings to 'Never Notify'

1. Go to Start screen. 2. Type Change

User Account Control settings. Select

Settings on the right then Change

user account control settings when it

appears on the left. 3. Select

the setting you want then select OK.
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Advanced Configuration

Encryption and TLS Protocols

As of version 7.3, LAW supports TLS 1.2 encryption protocols for Windows 10 systems. 

· For information on enabling TLS on your environment systems, we recommend you work with

your Administrator.  

· LAW is compatible with systems running TLS 1.2 encryption; TLS 1.0 may be disabled on these

systems.

· For instructions on enabling/disabling TLS 1.2 and 1.0, please reference

https://docs.microsoft.com/en-us/windows-server/security/tls/tls-registry-settings.

LAW FIPS Compliance and Configuration

Effective starting with version 7.5.X, CloudNine LAW is certified for FIPS encrypted Windows 10

operating systems.

Administrators can enable FIPS via either local system registry; or Group Policy.   

When enabled, the operating system will ensure that only FIPS validated hashing and

encryption modules are used by the operating system (including .NET libraries).

For more information on the FIPS encryption and usage with Windows 10, the STIG guidelines are

listed here for reference: https://www.stigviewer.com/stig/windows_10/.

Users can also reference the STIG guidelines for enabling FiPS encryption:

https://www.stigviewer.com/stig/windows_10/2019-01-04/finding/V-63811.

Antivirus Best Practices and Recommendations

With any eDiscovery processing tool, an anti-virus scanning utility can alter files and interrupt chain

of custody and hashing values.

https://docs.microsoft.com/en-us/windows-server/security/tls/tls-registry-settings
https://www.stigviewer.com/stig/windows_10/
https://www.stigviewer.com/stig/windows_10/2019-01-04/finding/V-63811
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Opening/Closing the LAW Management Console

With the LAWConsole.exe

To open the LAW

Management

Console, locate and run

LAWConsole.exe from

your LAW install

directory, usually found

in C:\Program Files

(x86)\LAW50\Console\.

1. Use Windows

Explorer to browse to

the path that

contains the LMC

executable file. By

default, file path is: 

C:\Program Files (x86)\Law50\Console\

2. Double click LAWConsole.exe.

The LAW Management Console screen appears. 

3. The LMC is configured through the LAW Configuration Utility.  It will use the same SQL server

that is configured as the Management Database .

Once opened, the LMC will continue to run in the background, even if the window itself is closed. To

re-open or fully close the LMC, use the LAW Management Client icon in your system tray.

To Open LMC

99
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Windows

10/Windows

Server

1. Mouse over the LMC icon located in the

Windows notification area.  

2. Click the LMC icon or right click the icon and then click Restore. 

The LMC starts. 

· If necessary, log on to an instance of SQL Server. 

· If the LMC icon is not visible in the Windows notification area, see the previous section in this

topic To start the LMC for the first time. 

LMC in the Notification Area

You can use the LMC icon in the Windows notification area to restore the LMC, stop the LMC, or

perform a quick check of its connection status to SQL Server.

Windows

10/Windows

Server

1. Mouse over the LMC icon located in the

Windows notification area.  

2. Perform the following tasks as needed: 

Task Steps

Restore the LMC. · Click the LMC icon.

Or 

· Right-click the LMC icon and then select Restore.

 

Stop the LMC. · Right-click the LMC icon and then click Quit.

Or

· Press ALT+F4 while the LMC is in focus.

Check the connection

status of the LMC to

SQL Server.

· Mouse over the LMC icon to view the tool tip. 

To Configure LMC to Start with Windows
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1. Start CloudNine™ LAW.

2. From the main window, on the Tools menu, click

Options, and then click Preferences. 

3. Select the Start the Management Console on

Windows Startup check box.

4. Click OK. Click Yes if you are prompted to start the

LMC.

The LMC starts. Every time you restart Windows,

the LMC will also start automatically but run

minimized. You can then restore the LMC by

selecting its icon in the Windows notification area.

Best Practices for insulating against unwanted AV impacts in processing include:

· Separate the Processing Network and other Review and Business Networks (e.g., separate LAN or

vLAN).

· Only run virus scanning after processing is completed (e.g., when moving processing volumes to

new locations for Production or Review Loading).

· If on-demand virus scanning is a compliance requirement, then scan only the file shares with

extracted ESI.

· These paths should be excluded to avoid impacts to processing speed and reliability:

o Installation directory 

o Local User Log Directory

o Local User Data store Directory

o Local Computer Data store Directory

o LAW Case Directory

o LAW Worker Temp Directory
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o Source data location

Additionally, users may reference the EDRM recommended practices regarding virus protection

here: https://www.edrm.net/resources/frameworks-and-standards/edrm-model/edrm-stages-

standards/edrm-processing-standards-guide-version-2/.

Set up your LAW case preferences

Tools > Options..., navigating to the Preferences tab

within the Options window

It is highly suggested to turn on 

· "Refresh duplicate status after deleting records"

· "Start the Management Console on Windows startup"

https://www.edrm.net/resources/frameworks-and-standards/edrm-model/edrm-stages-standards/edrm-processing-standards-guide-version-2/
https://www.edrm.net/resources/frameworks-and-standards/edrm-model/edrm-stages-standards/edrm-processing-standards-guide-version-2/


CloudNine™  LAW120

© 2025 CloudNine™

Virtual Machine and SQL Server Setups

  Virtual Workstation and SQL Server Setup for

CloudNine LAW

CloudNine™ LAW Server Workstations (Phyical, VM, Cloud, where

ever you want to install LAW)

The number of LAW workstations should reflect the number of users that you want to have access to

LAW at the same time. If you would like assistance in determining this, please consult with your 

Account Manager.

CloudNine™ LAW Turbo Server Workstations (Phyical, VM, Cloud,

where ever you want to install LAW)

The number of LAW Turbo Servers needs to cover the number of Turbo Import, Turbo Imager and

Turbo OCR agents that you wish to run. For Turbo OCR you will need the ABBYY engine installed on

each Turbo workstation and have a free ABBYY license for each workstation in the pool.

When it comes to Turbo Import and Turbo Imager, 1 Turbo worker = 1 agent = 1 CPU

core of a VM workstation.

Turbo OCR is on the workstation level. The ABBYY engine will use 1 license and all

cores available. If you would like assistance in determining this, please consult with

your Account Manager

The ratio of agent and RAM is a 1 to 4. i.e. for each core that Turbo is going to use, you should have

4gb or RAM. Also note if you have 4 agents of Turbo, an 8 cores workstation is great. 

CloudNine™ LAW SQL Server Recommendations
To avoid competition for resources, we recommend using separate SQL servers for LAW as follows:

The equation below is to help build out or right size your LAW SQL server.

SQL Infrastructure – right sizing SQL, remember to add 1 core for the OS
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Calculating LAW SQL Cores

· At minimum – the Total Number of SQL Cores should = The # of total LAW instances* that can

be communicating or interacting with SQL ÷ 3 

o Some LAW components work at the CPU core-level and others at thread-level…these would

be added together) 

Calculating LAW SQL RAM – Note when RAM starts to go over 100gb it is more of a bell curve and

must be adjusted by each environment.

· At minimum – the Total amount of SQL RAM should = The # of total LAW instances* that can

be communicating or interacting with SQL × 4 

A base bones SQL server would be 4 cores and 16gb or RAM
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Multi-Instance User Scenarios

As part of the enhancements that were added in LAW 7.4, you can now run multiple instances of

LAW on a single workstation.  

With multiple instances, a small litigation team can balance workflows and productions in parallel

without requiring multiple machines for each process.  For example, an attorney would be able to

log into a virtual or physical machine and perform document review and searching while an analyst

is tiffing on that same virtual or physical machine.  Another example would be an analyst running

productions while another user is importing. 

System Requirements that are outlines in this answer center are for one user on the

workstation. If you want to allow multi-users on the same workstation, then you will

need to increase resources. 

Taking advantage of multi-instance scenarios can result in an infrastructure cost savings:

LAW 7.3: Tiff, Import, Export, and Index at the same time -Requires 4 individual machines 

LAW 7.4: Tiff, Import, Export, and Index at the same time -Requires 1 machine with multiple user

instances 

The following sections provide a breakdown of how various LAW processes work in multi-instance

scenarios.

ED Loader

ED Loader is limited to one instance per virtual or physical machine.  When ED Loader is already

running and a user tries to open a second instance, the user will be notified that an ED Loader

instance is already running. 

TURBO IMPORT 

Turbo Import already supported multiple logins prior to the LAW 7.4 release.  You can run as many

instances up to the available cores on a virtual or physical machine. 

OCR 

Multiple OCR batch processes cannot be run.  If an instance of LAW is running OCR via Batch

Processing, a second instance will be prompted to create a distributed batch job, which will be

queued and automatically processed when the first instance is done or another LAW machine

(different virtual or physical machine) becomes available. 
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INDEXING 

Multiple LAW instances can not index the same case, but they can index different cases in parallel. 

The total number of index workers across all instances of LAW on a system is limited to the number

of available cores.  This is further limited by the "Index Workers" case setting. 

BATCH PROCESSING 

Only one instance across multiple user sessions can perform batch processing.  If an instance of

LAW is batch processing, a second instance will be prompted to create a distributed batch job,

which will be queued and automatically processed when the first instance is done or another LAW

machine (different virtual or physical machine) becomes available. 

SCAN 

Only one instance of LAW can be connected to any scanner on a system at a given time.  A user can

disconnect from a scanner to allow other users on the system to use it.  If a scanner is disconnected,

the next time LAW is launched, the scanner will not be connected automatically.

TURBO EXPORT 

Turbo Export is limited to one instance per virtual or physical machine.  When Turbo Export is

already running and a user tries to start a new Turbo Export, they will be informed that Turbo Export

is already running.

Law Management Console (LMC) 

One instance of LMC is allowed per machine.  If a user attempt to launch a second LMC on the same

system, they will be shown a message indicating the user that is currently running LMC on the

machine. 

ADMINISTRATION  

Multiple instances of LAW can generate reports, view documents, and perform administrative tasks. 
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